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Please observe the following notes

In order to ensure the safe use of the product described, you have to read and understand
this manual. The following notes provide information on how to use this manual.

User group of this manual

The use of products described in this manual is oriented exclusively to qualified electricians
or persons instructed by them, who are familiar with applicable national standards and other
regulations regarding electrical engineering and, in particular, the relevant safety concepts.

Phoenix Contact accepts no liability for erroneous handling or damage to products from
Phoenix Contact or third-party products resulting from disregard of information contained in
this manual.

Explanation of symbols used and signal words

hazards. Obey all safety measures that follow this symbol to avoid possible

2 This is the safety alert symbol. It is used to alert you to potential personal injury
injury or death.

DANGER

This indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

WARNING

This indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

CAUTION

This indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

The following types of messages provide information about possible property damage and
general information concerning proper operation and ease-of-use.

NOTE

This symbol and the accompanying text alerts the reader to a situation which may cause
damage or malfunction to the device, either hardware or software, or surrounding
property.

This symbol and the accompanying text provides additional information to the reader. ltis
also used as a reference to other sources of information (manuals, data sheets, literature)
on the subject matter, product, etc.
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Please observe the following notes

General terms and conditions of use for technical documentation

Phoenix Contact reserves the right to alter, correct, and/or improve the technical
documentation and the products described in the technical documentation at its own
discretion and without giving prior notice, insofar as this is reasonable for the user. The
same applies to any technical changes that serve the purpose of technical progress.

The receipt of technical documentation (in particular data sheets, installation instructions,
manuals, etc.) does not constitute any further duty on the part of Phoenix Contact to furnish
information on alterations to products and/or technical documentation. Any other
agreement shall only apply if expressly confirmed in writing by Phoenix Contact. Please
note that the supplied documentation is product-specific documentation only and that you
are responsible for checking the suitability and intended use of the products in your specific
application, in particular with regard to observing the applicable standards and regulations.
Although Phoenix Contact makes every effort to ensure that the information content is
accurate, up-to-date, and state-of-the-art, technical inaccuracies and/or printing errors in
the information cannot be ruled out. Phoenix Contact does not offer any guarantees as to
the reliability, accuracy or completeness of the information. All information made available
in the technical data is supplied without any accompanying guarantee, whether expressly
mentioned, implied or tacitly assumed. This information does not include any guarantees
regarding quality, does not describe any fair marketable quality, and does not make any
claims as to quality guarantees or guarantees regarding the suitability for a special purpose.

Phoenix Contact accepts no liability or responsibility for errors or omissions in the content
of the technical documentation (in particular data sheets, installation instructions, manuals,
etc.).

The aforementioned limitations of liability and exemptions from liability do not apply, in so
far as liability must be assumed, e.g., according to product liability law, in cases of
premeditation, gross negligence, on account of loss of life, physical injury or damage to
health or on account of the violation of important contractual obligations. Claims for
damages for the violation of important contractual obligations are, however, limited to
contract-typical, predictable damages, provided there is no premeditation or gross
negligence, or that liability is assumed on account of loss of life, physical injury or damage
to health. This ruling does not imply a change in the burden of proof to the detriment of the
user.
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Internet
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Subsidiaries

Published by

Statement of legal authority

This manual, including all illustrations contained herein, is copyright protected. Use of this
manual by any third party is forbidden. Reproduction, translation, and public disclosure, as
well as electronic and photographic archiving or alteration requires the express written
consent of Phoenix Contact. Violators are liable for damages.

Phoenix Contact reserves all rights in the case of patent award or listing of a registered
design. Third-party products are always named without reference to patent rights. The
existence of such rights shall not be excluded.

How to contact us

Up-to-date information on Phoenix Contact products and our Terms and Conditions can be
found on the Internet at:

www.phoenixcontact.com

Make sure you always use the latest documentation.
It can be downloaded at:

www.phoenixcontact.net/catalog

If there are any problems that cannot be solved using the documentation, please contact
your Phoenix Contact subsidiary.

Subsidiary contact information is available at www.phoenixcontact.com.

PHOENIX CONTACT GmbH & Co. KG PHOENIX CONTACT
FlachsmarktstraBe 8 P.O. Box 4100

32825 Blomberg Harrisburg, PA 17111-0100
Germany USA

Phone +49 - (0) 52 35 - 3-00 Phone +1-717-944-1300
Fax +49 - (0) 52 35-3-41200

Should you have any suggestions or recommendations forimprovement of the contents and
layout of our manuals, please send your comments to

t hoenixcontact.com
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PROFINET IO controller/device functions

1 PROFINET IO controller/device functions

The "PROFINET IO controller/device functions (UM EN PROFINET CTRL DEV) user

manual provides an overview of the PROFINET communication system with device
functions. This system description provides support when installing, starting up or operating
a PROFINET device system. Examples show you how to program IO device diagnostics.

1.1

User group of the manual

Use this user manual if your are responsible for programming user programs or configuring,
starting up and servicing automation systems.

1.2 Basic knowledge required

The following knowledge is required to understand the user manual:

General knowledge with regard to automation technology

Knowledge on how to use computers or equipment similar to a PC
(e.g., programming devices) under the Windows operating system

Knowledge of how to use PC WorX
Good knowledge of the PROFINET 10 communication method.

1.3 Additional PROFINET documentation

The PROFINET documentation is modular, providing you with optimum information.

Available "PROFINET basics" user manual
PROFINET documents UM EN PROFINET SYS

The manual describes PROFINET system basics.
This includes:

PROFINET development
PROFINET versions

PROFINET properties

PROFINET installation and startup
PROFINET and wireless

8037_en_00
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Quick start guides
— "Installing and starting up the starterkit 3.0" quick start guide
UM QS EN PROFINET STARTERKIT 3.0.

— "Configuring INTERBUS devices in a PROFINET IO network using the example of
STEP 7"
UM QS EN PROFINET PROXY IB

Device-specific data sheets

The data sheets describe the specific properties of PROFINET IO devices.
These include:

—  Function description

— Ordering data and technical data

— Local diagnostic and status indicators

— Pinassignment and connection example

—  Programming data/configuration data

PROFINET documents — "Acyclic communication" application note
in preparation AH EN PROFINET AZY KOM
— "PROFINET diagnostics" application note
AH EN PROFINET DIAG

Make sure you always use the latest documentation.
It can be downloaded at:

www.phoenixcontact.net/catalog

| o

1.4  System requirements

Please note that the PROFINET IO device function of the ILC170 ETH 2TX is only
available in the PC WorX software from version 6.00 Service Pack 2 or later (part of the
AUTOMATIONWORX Software Suite 2009 1.50 Service Pack 2).

The PC WorX Express software does not support these functions.

o

Firmware 3.5x for all controllers, including the PROFINET IO device function, is at least
required to use the PROFINET IO device functions.

o
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1.5 PROFINET IO controller/device functions

The master-slave procedure known from PROFIBUS was transferred to a provider-
consumer model with PROFINET. A Provider generates and transmits data which the
Consumer receives and processes. In terms of communication all devices in the PROFINET
network have equal rights. The configuration specifies how the field devices are assigned
to a central control system. PROFINET IO divides the control devices into 10 controllers and

10 devices. 10 controllers are typically control systems (e.g., a central vehicle control).

The interface for

IO devices was standardized by the PNO (Profibus User Organization)

(PROFINET IO and GSD). This allows control systems from various manufacturers to
communicate with 10 devices. During configuration IO devices are assigned logically to an

10 controller.

Process data is
=ent.

Systermn variables (master) Dievice variables
FHI0_FORCE_FAILSAFE FHD_S151_INPUTS
FHIO_SYSTEM_BF FHD_S5151_0OUTPUTS .
IO Controller Frio_svatem sF FND 5151 INPUTS STATUS [O Device

FHIO_CONFIG_STATUS_READY FHO_S151_0OUTPUTS_STATUS Process data is
FHIO_CONFIG_STATUS_ACTIVE FHD_5151_PLC_RUN processed.
PHIO_CONFIG_STATUS_FAULT FHD_S151_WALID_DATA_CYCLE
PHIC_DATA_VALID FHO_S151_DATA_LENGTH
PHIO_DATA_DIAG Recoived FHND_S151 ..

process data

is checked.

Figure 1-1 How communication works

PROFINET system variables (PROFINET IO controller)

System variable Type | Meaning
PNIO_FORCE_FAILSAFE BOOL | All outputs are set to the safe state "0".
PNIO_CONFIG_STATUS BOOL | Status of the active configuration in the context manager

PNIO_CONFIG_STATUS_ACTIVE BOOL

Communication is active.

PNIO_CONFIG_STATUS_READY BOOL

The context manager is active.

PNIO_SYSTEM_BF BOOL

An error occurred in the PROFINET network, that means, there is no
connection to at least one configured device. This value is not set if the
"Drive BF" parameter was set to FALSE for a device. This device is
removed from connection monitoring.

PNIO_SYSTEM_SF BOOL

At least one device reported a system error (diagnostic alarm or
maintenance alarm).

PNIO_DIAG_AVAILABLE BOOL

At least one device reported a diagnostic alarm with an active
connection.

PNIO_MAINTENANCE_REQUIRED | BOOL

At least one device reported the "maintenance demand" alarm with an
active connection.

8037_en_00
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PNIO_MAINTENANCE_DEMANDED | BOOL | At least one device reported the "maintenance request" alarm with an
active connection.

PNIO_DATA_DIAG If this bit is set, no device diagnostics is present.

PNIO_DATA_VALID BOOL | The application program must receive information on whether a

PROFINET IO device is supplying valid data or not. For this reason, the
"PNIO_DATA_VALID" process date exists on each PROFINET 10
device. Only if this bit is set does the PROFINET device supply valid data
and all other process values are valid.

PROFINET system variables (PROFINET IO device)

System variable Type Meaning
PND_S1S1_PLC_RUN BOOL Status of the higher-level control system/IO controller
PND_S1S1_VALID_DATA_CYCLE BOOL The higher-level control system/IO controller has established
the connection.
PND_S1S1_OUTPUT_STATUS_GOOD | BOOL I/O provider status of the higher-level control system/
10 controller
PND_S1S1_INPUT_STATUS_GOOD BOOL I/0O consumer status of the higher-level control system/
10 controller
PND_S1S1_DATA_LENGTH WORD Process data length that was configured for the 10 device.
PND_S1S1_OUTPUTS PND_IO_512 | OUT process data
[256] Memory area for OUT process data that the 10 device
[128] receives from the higher-level control system/IO controller.
(64]
(32]
PND_S1S1_INPUTS PND_IO_512 | IN process data
[256] Memory area for IN process data that the 10 device receives
[128] from the higher-level control system/IO controller.
(64]
[32]
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2 Network topologies

The following pages show three typical examples of network topologies.
These topology examples are to explain the dependence and/or independence of the
PROFINET IO controller/device functions.

The following hardware was used for the network structure:

ILC 330 PN 2988191-03
ILC 170 ETH 2TX 2916532-04
RFC 470 PN-3TX 2916600-07

FL SWITCH SMCS 4TX-PN 2989093-06

2.1 Topology 1: Mechatronic unit with lower-level
compact controllers

ILIC Zux

RFC 470
PROFINET-
Controller
ILCA70 .
FL Switch SMCS
PROFINET- "
Devices i
- I | Touch
F—— J Pamd
ILC 170 ILC 170
Figure 2-1 Topology 1: All devices in one network
Topology 1 describes a central concept with lower-level compact controllers. Every
compact controller (ILC 1xx) is an independent PROFINET IO device and handles a local
mechatronic unit with inputs and outputs. All controllers are available in a local network.
Realtime communication over the central controller (RFC 470 PN-3TX, ILC 3xx) takes place
over PROFINET. Controllers that are connected over a switch can be disconnected from
the network at any time.
8037_en_00 PHOENIX CONTACT  2-1
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2.2 Topology 2: Four identical machine controllers
under a machine park controller

! I
i RFC 470 #1 !
| PROFINET- i
i
i Controller FL Switch SMCS FL Switch SMCS |
| |
! T |
i i
g | |
; PROFINET- | RFC 4702223 |
! Devices | ' | [ :
' 192.168.0.1:24 L5 (. :

PROFINET- |17 . i R

Controller

PROFINET-

Devices

102 168.1.1:24 A92.168.1.1:24 192.168.1.1:24 192.168.1.1:24
Figure 2-2 Topology 2: Devices in several networks

Topology 2 describes a central concept with lower-level machine controllers.

Every machine controller (RFC 470 #2, #3, #4, #5) comprises a PROFINET IO device. This
machine controller comprises in parallel IO controllers with their own 10 devices. The lower-
level networks can use the identical IP address range since they are separated by the

controller.

The RFC #1 controller as well as the RFCs #2, #3 and RFCs #4, #5 on the device side are
located in a higher-level network. Being PROFINET IO devices, the individual I/Os are
located in a lower-level network.

2-2
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2.3 Topology 3: System control with lower-level

192.168.1.1:24

subsystems

A ﬁEE?ﬁE'""""""'""""""""""""i
! i
| PROFINET.- !

i
| Controller FL Switch SMCS FL Switch SMCS |
| - |
! i i
| |
| |
| |
| PROFINET- ILC 3xx !
: Devices _ ‘_ |
L T - -
: PROFINET- |
i Controller '
| |
' i
i PROFINET- !
! Devices |
! |
! |
! |

Figure 2-3 Topology 3: Devices in several networks

Topology 3 describes a central concept with lower-level system controllers. Every controller
comprises a PROFINET IO device. This controller is also an 10 controller with its own IO
devices. All controllers and 10 devices are located in one network.

8037_en_00 PHOENIX CONTACT  2-3
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3 Description of a typical application
(all devices in one network)

3.1 Information on how it was carried out

Alignment

The alignment of the data elements in the Inline controller memory can result in "data gaps"
when storing data in the memory. The compiler automatically fills these gaps with padding
bytes during the compiler process in order to prevent incorrect processing.

The disadvantage of the "automatic" filling of data gaps becomes apparent when data is
transmitted from the Inline controller to another controller. If this controller does not know the
memory algorithm of the Inline controller it will interpret the received data incorrectly.

It is therefore useful to program the filling of data gaps in your application program. Data
transmissions to other controllers can thus be taken into consideration. For example, use
byte arrays with an even number of bytes and/or word arrays in order to avoid data gaps in
your application program.

The following should be taken into consideration when creating the program:

— Create data types in flat structures, i.e., do not nest user-defined data types.

— Insert padding bytes manually in order to ensure the uniform size and layout of the data
types.

— When inserting padding bytes, please observe the memory alignment method of the
controllers used in the application (1-byte, 2-byte or 4-byte alignment).

8037_en_00
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Programming example with data gaps

The following program example shows how data gaps are filled.

1 TYPE
4 Struccl :
3 STRUCT
q ByreElement 3 BYTE;:
5 WordElewent : WORD :
3 END_STRUCT:
T
8 Struec? :
2 STRUCT
= 10 WordElemsnt 3 WORD;
Size: 11 EyteElement 3 BYTE;
12 END_STRUCT:
13
14 Structd :
15 STRUCT
14 ByLcElemenll 1 BYTE:
17 ByceElement2 : BYTE;
ie END_STRUCT:
19
Z0 Struccd :
z1 STRUCT
22 StructZElement Structd;
23 Seruct3Element Seruceld;
24 END_STRUCT:
25
26 Arrayl LRRAY [0..1] OF Structl;

=7 ENI'_TYFE

Struct1 Struct2 Struct3 Structd Array1
ByteElement ByteElementi
WordElement WordElement WordElement
Padding Byte ByteElement2
ByteElement ByteElement ByteElement
WordElement - - -
Padding Byte Padding Byte Padding Byte
ByteElement1
WordElement
ByteElement2
ByteElement
Padding Byte
Size: 4 bytes Size: 4 bytes Size: 2 bytes Size: 6 bytes Size: 8 bytes
Align: 2 bytes Align: 2 bytes Align: 1 bytes Align: 2 bytes Align: 2 bytes
Figure 3-1 Programming example with data gaps

Struct1 receives a padding byte after the ByteElement so that the WordElement is at a
WORD address (address that can be divided by 2 leaving no remainder). The alignment of
the overall structure is based on the data type used with maximum alignment. In this case
the WordElement specifies the alignment.

The size of Struct2 is calculated based on the elements used and the resulting alignment.
The corresponding number of padding bytes is inserted so that the size of the data type with
the value of the alignment can be divided by 2 leaving no remainder (data type size modulo
alignment = 0).

Struct3 does not receive any padding bytes as the maximum alignment corresponds to one
byte.

Due to the padding bytes that belong to the Struct2 structure, the Struct3 structure starts at
an even address. The number of padding bytes in array 1 corresponds to that of two
consecutive Struct2 structures.

3-2
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Programming example without data gaps

The following program shows an example of how data gaps may be filled in your application

program. Fill data gaps, which are to be expected due to the memory alignment, with
application data.

1 TYPE
2 Structl :
3 STRUCT
4 DyteElewment DYTE:
5 BytceE lement : BYTE: [{*Padding-Byre®)
& WordE lement @ WORD 2
7 END_STRUCT:
B
9 Struct2
10 STRUCT
i1 WordE lement WORD:
12 ByceE lement EYTE:
13 ByteElement : EYTE: | *Padding=Byte®)
14 END STRUCT:
15
16 Seructid
17 STRUCT
18 ByteE lementl E BYTE:
19 BvteE lemented : BYTE:
20 EHD_ST‘R UCT:
21
22 STRUCTE :
23 STRUCT
24 Struct2Element : Structl:
z5 Struct3Element Structi3:
26 END_STRUCT:
27
8 Arrayl : ARRAY [0..1] OF Scructi:
29 EIIID_TYPE
Figure 3-2 Programming example without data gaps

3.2 Typical application

In the following application all devices are in one network, see also the topology example on

page 2-1.
System variables Process data
= Value 1
ILC 330 PN ILC 170 ETH
PNIO_FORCE_FAILSAFE ) I_ILC170ETH1_0_PNIO_DATA_VALID
& | I_ILC17O0ETH1_0_PNIO_APPL_RUN

PNArr_OUT Q y | PND_lIO_256

{Value 1 is sent to the device,) (Value 1is processed and returned to the

I P Q controller,)

Figure 3-3 Typical application

8037_en_00
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The following devices are used for this application:

Device Order No. IP address
ILC 330 PN as master 2988191 192.168.0.5
ILC 170 ETH 2TX as device 2916532 192.168.0.7
FL SWITCH SMCS 4TX (optional) | 2989093

Notebook as programming device 192.168.0.10

' I
I

I
i |
] ILC 330 PN :
: ) ILC 170ETH
| FL Switch SMCS __ I
I . !
I I
I I
| I

I
I

I
I
I I
I I
I I
| I
| I

I
I
| I
I I
I I
I I
| I
| I

I
I
| I
I I
I I
| I

I
i |
! : =

Pc mmmmsssssso——ooooooe a!
| A | Address area:  192.168.0x :
1 - |
: : Subnet: 2552652550 :
_____________________________________________________________________________ 4
Figure 3-4 Typical application, all devices in one network

In this example, a project is created on the lower-level controller (ILC 170 PN) by requesting
the status variables of PROFINET communication (PND_S1S1). For this purpose, a
function block is created in structured text that sets the value "true" on the
ONBOARD_OUTPUT_BITO system variable. The LED is ON when the ILC 330 PN sends
the value "1".

In the example, a function block is used for logical ANDing. The
I_ILC170ETH1_0_PNIO_DATA_VALID and I_ILC170ETH_O_PNIO_APPL_RUN variables
(both system variables) map the status of the inputs to which the PNIO_FORCE_FAILSAFE
system variable is connected.

The PNIO_DATA_VALID system variable indicates for each PROFINET IO device whether
the connection to this PROFINET IO device was established successfully. Only if this bit is
set does the PROFINET IO device supply valid data and all other process values are active.

A negated result is linked to the PNIO_FORCE_FAILSAFE variable. The PROFINET
system is stable when the system variable PNIO_FORCE_FAILSAFE = 0. All outputs are
set according to the process data If PNIO_FORCE_FAILSAFE = 1 (at least one
PNIO_DATA_VALID variable set to 0), the safe state "0" is output for all PROFINET 10
device outputs.

3-4 PHOENIX CONTACT 8037_en_00
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In addition, the value 1 is assigned to the PNArr_OUT[0] variable (user variable). This is
done via the negated status of the PNIO_FORCE_FAILSAFE system variable. The value 1
is converted in the BYTE data type, since the PROFINET IO process data (PND_IO_256)
are assigned as ARRAY OF BYTE data type for the variable.
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3.3  Offline configuration

3.3.1 Lower-level project

e Selectthe "New Project..." command from the "File" menu to create a new project using

a template.

The tree structure and the selection of the control system are now prepared.

e Selectthe "ILC 170 ETH Rev. >01/3.50" control system and confirm your selection with

"OK".

New Project

General | CP 3w | CFX | Fwwe| ILC T | ILC 2 | ILC 3ux (€ oK

X

Rewv. > 0142560 m/2.00

0143580 01/2.00

ILC 150 GSM/GPRS  ILC 155 ETH Rew. »

ILC155ETH Rev. »  ILC170ETH Rev. »

~ Cancel

3]

Figure 3-5

Selecting the controller

¢ Select the "File, Save Project As/Zip Project As..." command.

e  Enter a project name (here: ILC170_Device) and save the project.

SavefZip project as

&

Save: | (2 Projects

~Q @

) Example
Example, rwk

File name: |ILE‘I 70_Device.mwt

| [see ]

File type: | Project Files [*.mwt)

Vl [ Cancel ]

Zip Optionz
Zip Uzer-Libraries
Zip Pf-Libranies
Zip Pagelayouts

Zip Frontend-Code

Figure 3-6 Save project
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Description of a typical application (all devices in one network)

The following window opens:

%8 pC WORX - ILC170_Device

i}

ile Edit Wiew Project Build Onlne Extras 7

= 4 Project
(3 Libraries
(=23 Data Types

] 2 o tpee Mame | Descrplion A
=23 Logical POLI: WADD  Addiion
g [@] Main W AND Bitwize AND
[&] MainT HWCTD  Counter Down
-2 Mairiy FCTU CounterUp
[E] Main WCTUD  Courter Up/Down A
=8 Physical Hardware &/ DIV Divisian 1
= 4 STD_CMF:eCLR ®;EQ Equal =
= ‘@8l 5TD_RES:ILC170_36 F_TRIG Faling Edge Detection
= &8 Tasks | GE Greater Than Equal »=
- 2O sToTEK D_EFAULT WGT Greater Than : >
~ =[0] Main:hain ELE Less Than Equal <=
-8 Mary BT LessThan ¢
i L) IED‘DEELYENTIES & MOD Muadulo Division
il 10_Configuration W MOVE  Assigns Yalus
WMUL  Muliplication
— s LE
omplement
B WAl @ g WOR  BiwissOR 3
IP/PROFINET: Configuration is checked.
Resource is checked (STD RES] ...
INTEREUS is checked (ILC 170 ETH 2TX, 0.0.0) ...
=4 b Y Build f Eners }, Wamings ] Infos § PLC Evers } Print J, Multi-Usar } Bus Configurator JFOT [
Far Help, press F1 62,2 € 22GB .}
Figure 3-7 PC WorX start screen
¢ Right-click on Logical POUs.
* Insert the function block.
i Project Tree Windaw i1y
253 Project
20 Libraries
23 Data Types
] sys_flag_types
Insert. .. °|_|'| Pragram
I )
' paste spcey | 2] Eunction
0.11 Funiction Block
Expand Al
PCU group
Save fs Metwork Template
Define Placehalders
% Propetties...
Mairty
Y Global Yariables
|0_Canfiguration
< i I 3
B Project POUs | Lﬂ Libraries | EB Hardware | Instances |
Figure 3-8 Inserting the function block
8037_en_00 PHOENIX CONTACT  3-7
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e Select the ST (Structured Text) language.
¢ Name the block "Data_Acknowledge".

Insert E|
Mame: I oK. ]
| Data_Acknowlegde |
l Cancel ]
Tupe Language
() Program D”: [ Help ]
() Function gg%c
(#) Function Block 0O EBD
OlLD
O FFLD [JUse Beserve
() MSFC
tode
FLC type: Processor type:
| <independent: w | | <independent: w |
Figure 3-9 Selecting the programming language and naming the function block

*  Open the worksheet by double-clicking on "Data_Acknowledge".

=3 Data Types
zyz_flag_types
=3 Logical POUs
= Data_Acknowlegde®
m Data_AckrnowlegdeT
Drata_scknowlegdet™
Data_scknowlegde™
= @ T
m b ainT
bl G
@ T
=53 Physical Hardware
=& STD_CNF: eCLR
=& STD_RES : ILC170_35%
=58 Tazks

Figure 3-10 Opening the worksheet
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Description of a typical application (all devices in one network)

* Insert the following program to your worksheet.

1 CHBOARD OUTPUT BITO := FALSE: =
2

3 if

4 EYTE_To INT(FND_ 3131 INPUT3I[O]) = 1

5

6 then

7 CMECARD OUTPUT _EBITO := TRUE:

[s}

=l end if;

10

< »

Diata_sckn...

Figure 3-11 Inserting the program

The ONBOARD-OUTPUT_BITO system variable and the PROFINET IO device status

variable PND_S1S1_INPUTS for the process data can be found under the

Global_Variables.

e Select the maximum process data length of 256 bytes (PND_IO_256) for the data
exchange between master and device.

i Tre_e Windaw o A Mame | Typ | Werwendung |Beschreibung e
SR P'°|99‘ o OMBOARD_IMPUT_BIT2 BOCL WAR_GLOBAL | Local input IN3 %h:
(0 Libraries " |oNBOARD_INPUT_BIT3 BOCL WAR_GLOBAL | Local input N4 bl
=3 D‘a Types " |ONBOARD_INPUT_BIT4 BOOL WAR_GLOBAL  |Local input N5 %M
_S}'S-"ag-‘ypes  |oNBOARD_MPUT_BITS BOOL WAR_GLOBAL | Local input ING HeM:
=13 Logical POUs | oNBOARD_INPUT_BITE BOOL YAR_GLOBAL  |Local input IN7 L
= Data_Acknowlegde” " |oNBOARD_INPUT _BIT? BOOL WAR_GLOBAL  |Local input ING o
Data_AcknawlegdeT ( [ONECARD_OUTPUT_BITO__|[BOCL VAR_GLOBAL _|Local output OUTT ) %M,
Dc'-tc'-_:i‘«cknowlegdet‘f ONBOARD_CUTPUT_BITY BOOL WR_GLOBAL  |Local output OLTZ2 bl
Data Acknowlegde | |oNBOARD_OUTPUT BIT2 |BOGL WAR_GLOBAL  |Local output OLITS Ell
=-[0] Main " |RTC_DAY IMT Wi _GLOBAL et
tainT T INT e (month) it
bl airiy — |RTcC —GLOBAL  |System time (year) %ol
@ tlain PMD_S151_PLC_RUM BOOL WAR_GLOBAL | Status of the higher-level control system X1
=@l Physical Hardware " |PND_S151_vALID DATA_ |BOGL WAR_GLOBAL |10 Contraller has established the connection %I
=8 STD_CNF: eCLR . | PRD_S151_OUTPUT_STAT... |BOGL VAR_GLOBAL |IOF status of the higher-level cortrol system )
=@ STD_RES : ILC170_35 " |PRD_S151_INFUT_STATUS... |BOOL VAR_GLOBAL |IOC status of the higher-level cortrol system I
=@ Tasks " |PMD_S151_DATA_LENGTH  WORD WAR_GLOBAL  |Process data lencth A
=-(0] STD_TSK: DEFAULT | | opp 5151 outeuts PND_IO_256 VAR_GLOBAL | Output process data %k
(" [PHD_5151_INPUTS PND_I0_256 WAR_GLOBAL |Input process data B el
- IB_DEYICE_PARAM_ACTIY... |BOOL WAR_GLOBAL  |Interbus device configuration activated EAH
iTj Gl = N |B_DEYICE_PARAM_READY |BOOL WAR_GLOBAL  |Interbus device configuration completed Fohd:
[ 10_Configurtion | |IB_DEVICE_PARAM_ERROR |BOOL VAR_GLOBAL |Interbus device configuration error ST v
< *ll< >
& '-lﬂl EB Data_tckn... Global Vari...
Figure 3-12 Selecting the process data
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e Afterwards insert the created function block in the "Main" worksheet using drag & drop.

2 Project Tree Window E x| —1| | & Edit uizard EO x|
=23 Project : PS A | Graup:
[Z3 Libraries <allFUz and FBz» b
253 Data Types
ez flag_types Eame D=~
=43 Lagicsl POUs Data_Acknowlegde &;CTU Eou
= Data_acknowlegds” W CTUD Cot
(i) Data_AcknowiegdsT [Data_Acknowlegde] 4 D_BCD_TO_DINT Cor
Data_Acknowlegdel! WD BCD_TO_INT Cor
Data_Acknowlegde WD _BCD_TO_SINT Cor
=-[0] Main® 8 [).ata ,
MainT 4 DELETE Del
Mairty” 3 DERIVAT Diff
(& Man 4 DIGITAL N Re.
SR F'hysmaIHardw.are ) + & DIGITAL OUT Gt
= &8 STD_CMF : eLLR ~ *| | ®oiNT_T0_B_RCD Cor
< : > IE ¥ B DINT_TO_BCD Cor,
¥ @m T ——— B 0 2
Figure 3-13 Inserting the function block into the worksheet
e Compile the project and save it.
¢ Close the project.
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Description of a typical application (all devices in one network)

3.3.2 Higher-level project

e Selectthe "New Project..." command from the "File" menu to create a new project using
a template.

The tree structure and the selection of the control system are now prepared.
e Selectthe "ILC 330 PN Rev. > 01/4.6F/3.50" control system and confirm your selection
with "OK".

New Project |

P 3wt | CP || FCn | ILC 12 | ILC 2w | ILC 3ue | RFC 4o € oK
5 A ~ Cahcel
BN ]

Project Wizard ILC 330 ETH Rew. =
01,/4.6F/2.00

IR = [ =
b B e s

ILC330ETH Rev. > ILC 330 PN Rev. »
01/4.6F/3.50 01/4.6F/3.00

=] B
R

ILC 3G0ETH Rew. »
01/4.6F/2.00

£

—n =

Figure 3-14 Selecting the controller

e Select the "File, Save Project As/Zip Project As..." command.
e Enter a project name (here: ILC330_Controller and save the project.

SavelfZip project as .@
Save: | [ Projects v |0 ¥ e o
) Example

Example.mwt

File name: |ILC330_Controller. mut L | save |
File type: |F'roiect Files [*.rowt] v| [ Cancel ]
Zip Optiong
Zip Uszer-Libraries Zip Frontend-Code
Zip Fw/-Libraries

Zip Pagelayouts

Figure 3-15 Save project
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'.'_'ﬁ PC WORX - ILC330_Controller

The following window opens:

=3 Project

3 Edit iz 2o

Group:

[ Libraries zall Flis and FBs>
=0 Data Types -
(. sps_flag_types i DEﬁ:
! |
(=23 Logical POUs W ABS Tu—
B [E] Main B ACOS Arc
~{i] MainT W ADD Ad
haini' W aDD_T_T Tihe
~[E] Main W ADDR_TO_ID
= 88 Physical Hardware &/ AND Bilv
=58 STD_CNF:&RM_L_40 /4R _MGT
= &8 STO_RES : ILC330PN ;25N Are
-8R Tasks B/ A5l
=] @ STD_TSK : DEFAULT & A5R
=0 a‘”N;:nz‘” B/ ATAN A
fﬁ Global_ariables & B_BCD_TO_DINT L
mH o En;hguratlnn B EB_BCD_TO_INT i
- W E_BCD_TO_SINT Cor
W BCD_TO_DINT Cor
W BIT_TEST Loz
M BOOL_TO_BYTE Cor
& m | 5 4 BO0L_TO_DINT Cor
= W EBOOL_TO_DWORD Corae |
i |'|E||‘| £l I | ¥
IP/PROFINET: Configuration iz checked.
Resource is checked (STD_RE3) ...
INTEREUS is checked (ILC 330 PN, 0.0.0) ...
+ N\ Build [ Evos J, Wamings J, Infos J, FLE Errors J, Print J, Multi-User i Bus Configuratar j FDT /
For Help, press F1 10,7 cf 2PGE |
Figure 3-16  Start screen
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Description of a typical application (all devices in one network)

e Firstintegrate the ILC 170 ETH 2TX as a PROFINET IO device into the bus structure.
¢ Change to the bus structure. To do this, click on the "Bus Structure" icon in the

toolbar.

e Insertthe ILC 170 ETH 2TX as a device into the bus structure (right click).

2 Bus Structure 1 a4

= ILC330_Controller
=l 1LC 330 PN 192.168.1.2
=~/ Resaurce
R STD_RES ILC330PN
5 PROFINET
=l # INTERBUS 0. O
P+ 1muz4p140.1

Unconnected

1 Device Catalag L |

=29 Phoenix Contact ~
-0 AHL
-0 CP3wx
w2 CT
w1 ELR
-0 FC2em
-0 FC3xx
w3 FDT
w1 FL
- FLM
- FLS
£ FP

w1l
#7 IL 2MED Display Data Shest

-7 ILB Celete Device

Import Device. .. Chrl+1
Copy Device Chrl+C

=) ILCTxx Irmport G50 File, .

=43 PLC Create new INTERBUS Device Description,. .
B ILC130ETH Rev. »=0143.

BH ILC130ETH Rev. »=0143.|  CreateCatalog ...

Bl ILC150ETH Rev. »= 0142  Import Catalog ...

[ ILC 150 ETH Rev. »>= 0143,

[ ILC 150 GSMAGPRS Rew.

[ ILC 150 GSMAGPRS Rew.

B ILC 155 ETH Rev. »>= 0142,

[N ILC195ETH Rew. »= 0173, Wiew as Grid ChrhG
BE ILC155ETHR =01/3 Edit Catalog Representation. ., Chrl+E
L RILC1F0ETH

| £

Figure 3-17 Inserting the ILC 170 ETH 2TX as a device in the bus structure
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The PROFINET device inserted will be displayed in the Bus Structure workspace. The IP

address is created depending on the IO controller address.

2 Bus Struchure 2 & [/ |2 Cevice Details iv@m
= @ ILC330_Conkraller ILC 170 ETH 2TX (DEVICE) ilc-170-device32 192,168.0,3 \PROFINET Settings),
=-Fll ILC 330 PM 192.168.0.2
=R Resource Mame Yalue
R STD_RES ILC330FH [ | vendor Phoenix Contact
= [ | vendarID 00080
[ | Designation ILC 170 ETH 2T (DEVICE)
[ | DevicelD 00035
[ | Functional description
= g% ¥ INTERBUS 0. 0 [4 | Device bype PLC
- #LIBI 240140, 1 [ | Device Family ILC1xx
Hncennected [ | Order number 2916532
[ | Revision X%
[ | DNS/PROFINET Device Mame ilc-170-device3z
[ | Station Mamne
[ | Device Name
- [ | Module Equipment ID
iDevice Caidog 248 T | 1P address 192.168.0.3
#-(] Festo [ | Subnetmask 255.255.255.0
#-(_ Phoenix Contact [ | Defauk Gateway
(1 Universal [ | Realtime class RT
] Reduction ratio input 16 s
] Reduction ratio output 16 s
[ | Faulty telegrams until connection is aborted 12
[ | Monitoring Time Inputs {ms) 192
[ | Monitoring Time Outputs {ms) 192
[ | Gperation in case of configuration differences no
[ | Log connection state ves
] Drive BF YES
[ | tode 1D 215
Al )\ PROFINET Settings |4 PROFINET Stationnames ‘® Businterfaces | %] Data shest
Figure 3-18  TheILC 170 ETH 2TX integrated as PROFINET device in the bus structure

The process data of the PROFINET device will be displayed in the Device Details
workspace of the "Process Data" tab.

2 Bus Structure 4 v [/ |2 Device Detais ER x|
= @ ILC330_Contraller 1 EAZS6: ILC 170 ETH 2Ti (DEVICE) \Process Datal,
-l ILC 330 PN 192.168.0.2
- Resource Process Data Erybe, Bit jfjs} Function Texk Terminal equi...
R STD_RES ILC330PH [ [ qezse [ Jon [1 [ [ |
= §5 PROFINET [ | 1256 [ Too [ g [ [ |

=Bl 1LC 170 ETH 2T (DEVICE) ilc-170-device32 192.168.0.3
<> 0@ILC 170 ETH 2TK (DEVICE)
@ 1 EAZSE: ILC 170 ETH 2T (DEVICE)
= # INTERBUS 0 . 0
BB #1En 2401401

Unconnected

B Module Settings | 58! Frocess Data | 2] Data sheet

Lht

Figure 3-19 Process data of the PROFINET device
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Description of a typical application (all devices in one network)

En

e Switch to the IEC programming and open the "Main" worksheet.

e Add the mapped function blocks.
¢ Negate the output at the AND block.

2l

AND

‘—[ NOT ] BOOL_TO_BYTE

L« >
P MainMain
Figure 3-20 Adding function blocks

For the system variables for displaying the status of a PROFINET IO device, the process

data is generated automatically.

e Switch to the process data assignment workspace.

¢ Inthe top left window, "Symbols/Variables", select the program
(here: Main : Main).

¢ Highlight the PROFINET IO device in the top right window.

e Highlight the PNIO_APPL_RUN variable in the bottom right window.

e Enable the context menu on the variable and select the "Create Variable" command. In
this case, a variable is generated automatically.

* Proceed in the same way for the PNIO_DATA_VALID variable.

2 Process Data Assignment 1vO
Symbals/Variables = @ 1LC330_Controller
= @8 STD_CHF : ARM_L_40 T ! %C :332;:\:(1392‘163‘0‘2
=-‘@# 5TD_RES : ILC330PN
= Defallt R STD_RES ILC330PN
System Variables =38 PROFINET
-0l ;D ek : DEFAULT = [l 1LC 170 ETH 2T (DEVICE) flc-170-device32 192,168.0.3
=@ ot [D ¢ 0@ILC 170 ETH 2TH (DEVICE)
Defait o | EAZSE: ILC 170 ETH 2T (DEVICE)
Ao =% # INTERBUS 0. 0
P#1ELzd040.1
Unconnected

SymbolfVariable Data Type Process Data [tem Device Process Data Ikem jiie] Data Type
PRIO_APPL_RUN BOOL 0@ILC 170 ETH 2TX (DEVICE) ~PMIO_DATA_STATE I BYTE
PMIO_DATA_VALID BOOL 0 @ILC 170 ETH 2T (DEVICE) |, PNIO_DATA_VALID 0@ILC 170 ETH 2TX (DEVICE) PMIO_I5_PRIMARY I BOOL

Pl ATA_YALID [ EOOL

P APPL RN oo |

_No_DIAG Select &l Chrl+A
1 EAZS6: ILC 170 ETH 2T4 (DEVICE) Q256 Search... CHi+F
1 EAZS6; ILC 170 ETH 2TX (DEVICE) 1256
Filter 3
v Color-coded view
Chri+¥
Chri+E
< ¥ | ¥
Figure 3-21 Creating variables
8037_en_00 PHOENIX CONTACT 3-15

DOWNLOADED FROM WWW.SCATTS.CO.UK



DOWNLOADED FROM WWW.SCATTS.CO.UK

UM EN PROFINET CTRL DEV

e Inaddition, create the "PNArr_Out" variable with the "PND_IO_256" data type as "VAR-

EXTERNAL".
Mame Tup | Wenwendung |Beschreibung |
| & Default
PM A _Out PMD_IO_256 WAR_EXTERMAL

[ 1L TOETHT _0_PMIO_APPL_RUN
1Lt 70ETHT _0_PrMIo_DaTA_VALID
 |FMIO_FORCE_FAILSAFE

<

BOOL WaR_EXTERMNAL_PG
BOOL WAR_EXTERMAL_PG
BOCL WAR_EXTERNAL Al PROFIMET devices are prompted to set th...

¥

T MainMain I airiv: b4 ain

Figure 3-22 Creating the "PNArr_Out" variable

e Tolink the process data to the variables, proceed as follows:

* Inthe top left window (Symbols/Variables) select "Default".

¢ Highlight the PROFINET IO controller in the top right window.

e Highlight the "ILC 170 ETH ..." variable in the bottom right window.

e Connect the "PNArr_Out" variable to the "I256" process data item of the
ILC 170 ETH 2TX device.

The total available data width of 256 bytes was selected in this example. You can change it
later in the online configuration.

= Process Data Assignment ER A x|
Symbols/Variables = @ ILC330_Conkroller
= ‘@8 STD_CNF : ARM_L_40 T ! };C :22:::(?2'168'0'2
= STD_RES : ILCS30PN
ﬁ I;efault R STD_RES ILC330PN
System Yariables = 4 PROFINET
H @ S:D TSK : DEFALLT =) Bl 1LC 170 ETH 2T% (DEVICE) ilc- 1 70-device32 192,168.0,3
= @ ;‘Iain -. Main D 0 @ILC 170 ETH 2Tx (DEYICE)
D;aFau\t 3 1 EAZSE: ILC 170 ETH 2TR (DEVICE)
P = o # INTEREUS 0, 0
E#IIEILZ‘?DI‘GU.I
Unconnected
Symbolfvariable Data Type Process Data Item Device Process Data Item 0 Data Type
PRArr_Cuk PMD_IO_256 0 @ILC 170 ETH 2Tx (DEVICE) ~PNIO_DATA_STATE I BNTE
0 @ILC 170 ETH 2T {DEVICE) PNIC_IS_PRIMARY I BOOL
0 @ILC 170 ETH 2T (DEVICE) PNIO_DATA_VALID I BOOL
0 @ILC 170 ETH 2T% {DEVICE) PMNIC_APPL_RLUM I BOOL
0 @ILC 170 ETH 2Tx (DEVICE) PNICQ_MO_DIAG I BOOL
T0ETH 2T% (DEVIC I
Select al
F1IBIL24DI40.1 Search... CHl+F
#1IBIL240140.1
#1IBIL24D140, L Filter y [BoOL
F1IBIL24DI40.1 EITSTRIN...
Ctrl+B
Chrl+y
Create Yariable CrHE
AN ES >

Figure 3-23 Connecting the "PNArr_Out" variable to the process data
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Description of a typical application (all devices in one network)

e Switch to IEC programming and link the variables as shown in the figure below.
¢ Add a negation to the output of the AND block.

The "PNIO_FORCE_FAILSAFE" system variable is used at the output of the AND block and
the input of the "NOT" block.

—
.3
AN
[_ILCI70ETHL_O_PNIO_DATA_VALID D—PNIO_FORCE_FAILSARE
I_ILC170ETHI_O_PNIC_APPL_RUN

MNCT BOOL_TO_BYTE
PHIO_FORCE_FAILSARE MArT_Cut[0]

JE: >
T Hainain

Figure 3-24 Inserting and linking variables

e Select the "0" array in the byte array by writing the field "[0]" after the "PNArr_Out"
variable.
e Then compile the project and save it.
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3.4  Online configuration

3.41 Preparing the PC for communication

e  For configuration and parameterization assign an appropriate IP address for your PC
within the 192.168.0.x address area.

In this example the PC receives the address 192.168.0.10.

Internet Protocol (TCP/IP) Properties |E| E|

General |

“'ou can get |P zettings assigned automatically if your networl, supports
thiz capability. Othenvize, vou need to azk your netwaork, administratar for
the appropriate |P zettings.

" Obtain an IP address automatically
(%) Uge the follawing IP address:

P address: | 192.168. 0 .10 |

Subret mask: | 255 . 255 . 2855 . 0 |

Default gateway: | . . . |

() Use the following DNS server addresses:
Freferred DMS zerver: | . . . |

Alternate DMS server: | . . . |

I Ok, ]l Cancel l

Figure 3-25 Assigning an IP address

¢ Select the network card of your PC that is to be used for communication in the
"Tools/PROFINET..." menu of PC WorX.

PROFINET %]

Communication |

Ethernet Metwark Board Generic Marvel Yukon 33E 8053 baged Ethemnet Controller - SecuRem |
Please chooge...
DCP Tirmeout b arvel vukon B33E 3055 igabit Ethernet Contraller - SecuR enmote b

Generic b zed Ethernet Controller Remote
Check Paint Virtual Network Adapter Faor SecureClient - SecuRemate Minip

ak. ] [ Cancel

Figure 3-26 Selecting the network card

Now the PC is ready for communications within the subnet.
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Description of a typical application (all devices in one network)

3.4.2 Configuring the ILC 170 ETH 2TX

Assigning IP settings

To set the IP address in PC WorX proceed as described below:
e Open your project "ILC170_Device".
e Establish an Ethernet connection between your PC and the controller.

* Inthe PC WorX menu bar, select the
"Extras... BootP/SNMP/TFTP-Configuration..." menu.

|58 pc WORX -

E File Edit Wwiew Project Buld Online Eatrasl I
H ; 2 o Pagelawvout Editor
Tar Sreneponmeerel B

= .. | Create OPC Yisualization File
Sl e e T SR

1 Bus Structure

Reset DA-Addresses

PROFIMET Configuration ...

| BookP ShMPY TFTP-Configuration ...

Check Source Starages

Shartcuts,

Options...
Figure 3-27 Selecting "Extras/BootP/SNMP/TFTP-Configuration..."

e  Activate the "BootP server active" checkbox.

BootP Settings _\

BootP |

[1Bouif Server active

Figure 3-28 Activate BootP server

e Switch to the bus configuration workspace, see Figure 3-30
e Select the controller node.
e Select the "IP Settings" tab in the "Device Details" window.

¢ Enter the MAC address of the controller. It is printed on the device and starts with
00.A0.45.

8037_en_00 PHOENIX CONTACT 3-19

DOWNLOADED FROM WWW.SCATTS.CO.UK



UM EN PROFINET CTRL DEV

DOWNLOADED FROM WWW.SCATTS.CO.UK

/ < 7805A012
Figure 3-29 Printed MAC address on the ILC 150 ETH controller

% Bus Struchure 7 & [ |2 Device Detsil 1vQ
[=] § ILC170_Device ILC 170 ETH 2T 192,168,0.7 \IP Settings),
=-Hll ILC 170 ETH 2T¥ 192,166.0.7
=R Resource MName Yalue
R STD_RES LC170_35 [ | vendor Phoenix Contack
#% # INTERBUS 0. 0 [ | Designation ILC 170 ETH 2T
Unconnected [ | Functional description Inline Controller For Ethernet Ketworks With & ...
| Device bype PLC
[ | Device Family ILCIxx
[ | order number 2916532
[ | Revision 0143,50
i Drevice Catalog 2 4 3 Station Marme

%1 Festo [ | Device Name

& (1 Phosnix Contact [ | Module Equipment ID

-] Universal ] DMS/PROFIMET Device Mame ILC170ETHL
[ | MAC Address
[ | 1P Address
[ | Subnetmask 255,255, 255,10
[ | Default Gateway

Al 1P Settings E Extended Settings | #§ Communication | £y CRU Service Editor | 5% Bus interfac 4 »

Figure 3-30 Entering the IP address

e Perform a cold restart for the controller.
e To do this, switch the supply voltage off and then on again after around 2 seconds.
The controller is assigned the IP address, which is specified in the project for the controller

(here: 192.168.0.7). The following message appears in the message window in the "Bus
Configurator" tab.

Configured dewice (ILC170ETHL) cqueries for its IP paraweters wvia BootP.
The dewice (ILC170ETH1) receiwved its IP parameters (IP Address:192.168.0.7,5ubnet Mask:255.255.255.0,Default Gateway:) wia BootP.

5 Meszage Windc 4u % [

Y Build | Errors J, Wamings } Infos J, PLC Emors Ji Print } Multi-User ) Bus Corfigurstor AFDT J

Figure 3-31 Message window

The IP address will now be permanently stored on the controller Flash memory.
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Switching on the PROFINET IO device function

° The following applies to the devices:
1 ILC 170/330/350/370/390 PN / RFC 470 PN-3TX
By default upon delivery the PROFINET IO device function is switched off for every
controller.
e Switch to the "Extended Settings" tab.
e Select the "IO device status" item in the device details under "Network Settings".
e Under "Settings", select "activated" in the pull-down menu.
= Dewice Details L x|
ILC 170ETH 2TX 192,168.0.7 \Extended Settings),
3 Metwork Setti ]
) Ethermet
SMMP agent deactivated R
10 device staktus
PROFIMET Device deackivated
L J X J
|foline
@ IP Settings | E Extended Settings | A& “ommunication _j CPU Service Editar | 4% Bus interfaces | (5] Data sheet
Figure 3-32 Device function activated
e Click on "Transmit".
* Inthe "Settings Communication Path" dialog confirm with "OK" the suggested IP
address or the one you have selected for your application.
Settings Communication Path
| Ethemet [192.168.0.7) v
[ aF. { [ Canicel ]
Figure 3-33 Setting the communication path
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Successful execution of the service will be displayed in the status window.

& Device Details

ILC 170 ETH 2T¥ 192,168.0.7 |Extended Settings!,

3 Mebwark Settings
%] Ethernet
SHMP agent

5| 10 device status
PROFINET Device

Settings

activated

B2 IP Settings E Extended Settings | o Communication | &fg CPU Service Editor

u

% Busintetfaces | =] Data shest

Figure 3-34

To transfer the network settings you have to reset the 10 controller.

Status window

e Select the "Ethernet" item in the Device Details window under "Network Settings".

The device name in the higher-level project (ILC 170 ETH device) must match the device
name of the lower-level project (ILC 170 ETH).

* Inthe "Activate Network Settings" area click the "Reset Control System" button.

& Device Details

ILC 170 ETH 2T+ 192,168,0.7 \Extended Settings),

E x|

3] Metwork Settings
g
[E] SNMP agent
E 10 device status
| PROFINET Device

Metwork Settings
() Manual definition of the TCP{IP settings
TP Address:
[ 192 e . o0 . 7 e

Subriet Mask:
255 . 2% . 5 . 0
Gateway Address:

O Usage of & BookP Server

DMS/PROFINET Device Mare
ILCIF0ETHL

FReal-time Clock Settings
Time:

10:00:31
Date:
Mortag ,29. Marz 2010 5

Send

Send

System Time

Send

Settings
Read
Activate Metwork Settings
[ Reeset Control Syskem
FTF
[ Open FTP Folder on Device

|fo|ime

B IP Settings E Extended Settings | #f Communication &[3 CPU Service Editor | 4% Bus inkerfaces | 2] C ¢ »

Figure 3-35

Resetting the controller
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Description of a typical application (all devices in one network)

* Inthe "Settings Communication Path" dialog confirm with "OK" the suggested IP
address or the one you have selected for your application.

Settings Communication Path E|
| Ethemet [192.168.0.7) |
[ 0ok, i [ Cancel l

Figure 3-36 Setting the communication path

Successful execution of the service will be displayed in the status window.

Activate Metwork Settings

FTP

I ()

@ P Sett\ngs| E Extended Settings ‘4 Communication j CPU Service Editor | 5% Bus inkefaces ﬂ Cd s

Figure 3-37 Status window

The input/output data ranges available for the ILC 170 ETH 2TX as PROFINET IO device
are displayed under "Network Settings" -> "PROFINET Device".

= Device Details
ILC 170 ETH 2T 192.168.0.7 \Extended Settingsh

3 Mebwork Settings Mame Walue -
Ethernet 1 |Input range 256 bytes -
| SMMP agent 2
| 10 device status

ROFINET Device

Output rahge 256 bytes -

=
| | >

B 1P Settings | E Extended Settings | A Communication || £}y CPU Service Editor | 4% Bus interfaces | & Data shest

Figure 3-38 Input/output data ranges
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To set the task to update the I/Os, select the device resource in the Bus Structure window.

e  Set the update task to "DEFAULT".

= Bus Structure 2 w [/ |5 Device Details LI x|
ﬁ ILC170_Dewice STD_RES ILC170_35 \Resaurce!
=-§ll ILC 170ETH 2T 192.166.0.7
=R Resource MName Value
R STD_RES ILC170_35 [ | Configuration STD_CHF
ﬁ # INTEREBUZ 0. 0 [ | resource name STD_RES
Unconnecked [ | PLC bype eCLR
[ Processar bype ILC170_35
[ | 1jo Update by Task <DEFALLT =
@ Resource

e

Figure 3-39 Setting the update task

3.4.3 Configuring the ILC 330 PN

To configure the ILC 330 PN controller, proceed as described in Section "Configuring the

ILC 170 ETH 2TX" on page 3-19.

Assigning IP settings

Open the higher-level project "ILC330_Controller" and proceed as described in Section

"Configuring the ILC 170 ETH 2TX" on page 3-19.

Please not the following modifications:
— Enter the MAC address of the ILC 330 PN controller.
— Assign the IP address 192.168.0.2.

To use the PROFINET device functions, the following conditions apply for the
"ILC330_Controller" project.

ILC 330 PN settings as PROFINET controller:

IP address: 192.168.0.2

Subnet mask 255.255.255.0

PROFINET device name: ILC330PN1

ILC 170 ETH 2TX settings as PROFINET IO device:

IP address: 192.168.0.7

Subnet mask 255.255.255.0

PROFINET device name: ILC170ETH1

ILC 170 ETH as a device (here: ILC170ETH1).

Please make sure that the same PROFINET device name of the ILC 170 ETH (here:
ILC170ETHT1) is used in the lower-level project as in the higher-level project for the
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Description of a typical application (all devices in one network)

3.4.4 Observe startup behavior

Starting up the controller is the easiest way to check whether

— The controller is correctly parameterized

— The IO devices have the right name

— There are double names or double IP addresses in the system.

Compile the ILC330_Controller project with the bus configuration. There will be a warning
message if there is no application program. You can ignore this message.

Make sure that the controller has the IP address that was set in the project. Start the project
control dialog via the menu bar.

If the message "Timeout" appears after 10 seconds, the project and device addresses do
not match. It is also possible that the IP address of the computer has not been set correctly.

The controller can be reset from the project control dialog. The existing project will be
deleted. Start the download and perform a cold reset. Afterwards the BF LEDs must go out
on all devices.

To access the network status from the program, the following system variables are mapped
in the global variables of the programming environment. Activate the "Debug On" operating
mode and the values of these variables will be displayed.

Global variable Description

PNIO_CONFIG_STATUS_ACTIVE | Connection to these devices is being established
or has been completed.

PNIO_CONFIG_STATUS_READY | The connection establishment to the devices has
been completed.

8037_en_00
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3.4.5 Checking the program start of the higher-level project

When the program is started correctly, the following screen will be shown in the Debug

mode:
—1
o~
[ILCI70ETHL_O_PNIO_DATA _WALID PHIO_FORCE_FAILSAFE
1 0
[LILCI70ETHL_O_PNIO_APPL_RIM
1
MNOT BOOL_TO_BYTE
PHIO_FORCE_FAILSAFE MNArr_Out[0]
0 16#01
w
NEs >

T Mainchain

Figure 3-40 Program status

The PNIO_FORCE_FAILSAVE variable is in the FALSE state, thus communication is
ensured and the outputs are set according to the process data.

If you remove the voltage connector of the ILC 170 2TX or change the device to the "Stop
Mode", the status of PNIO_FORCE_FAILSAFE will change to TRUE. All outputs will be set
to "0" and the value "1" is no longer transferred to the device.

—l
Eal
AND
[LILCI70ETHLI_O_PMNIC_DATA_VALID C—PIO_FORCE_FAILSAFE
0 1
[_ILCI70ETHLI_O_PMNIO_APPL_RIIN
0
MNOT BOOL_TC BYTE
PHICO_FORCE_FAILSAFE AT _Out[0]
1 16£00
V
NEs >
& Main:Main
Figure 3-41 Program status in "Stop Mode"
8037_en_00
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Description of a typical application (all devices in one network)

3.4.6 Checking the program start of the lower-level project

The behavior described before can also be observed in the ILC170_Device project.
* Please open the lower-level project of the ILC 170 ETH 2TX.
e Then open the "Data_Acknowledge" POU and activate the Debug mode.

The following screen appears:

1 TRUE |ONBOARD OUTPUT EBITO := FALSE: =

2

3 16#01 |if BEYTE_TO INT(PND_3131 INPUTI[0]) = 1

4

5 then

& TEUE CNEOQARD OUTPUT _EITO := TRUE;

7

(=] end if;

=]

NES >

E Drata_Ackn

E Wariable Walue Drefault value Type Instance

2 S1_| PND_I0O_256 | STD_CMF.STD_R...
[0 1E#01 EYTE STD_CMNF.STD_R...

3 [1] 1E#00 EYTE STD_CMNF.STD_R...

! [2] 1E#00 EYTE STD_CMNF.STD_R...

E [ 1E4#00 EYTE STD_CMF.STD_R...

_é: ' wistch 1 i Watch 2 Jy Watch 3 J, Watch 4 ]

Figure 3-42 Program status active

The value 1 is in array [0] of the PND_S1S1_INPUTS. The ONBOARD_OUTPUT_BITO
variable is TRUE and the LED is ON.

1 FALSE [(ONEOQARD OUTPUT EITO := FALSZE; =

2

3 if BYTE_TO INT(PND_3131 INPUTI[0]) = 1

4

5 then

& FALS3E CNEOQARD OUTPUT _EITO := TRUE;

7

(=] end if;

=]

NES >

E Drata_Ackn

E Wariable Walue Drefault value Type Instance

P 5 | |PND_IO_356 |[STD_CHF.STD_R..

(BRI EYTE STD_CMNF.STD_R...

[1] 1E#00 EYTE STD_CMNF.STD_R...
[2] 1E#00 EYTE STD_CMNF.STD_R...
[ 1E4#00 EYTE STD_CMF.STD_R...

5 itatch Wiindow

' wistch 1 i Watch 2 Jy Watch 3 J, Watch 4 ]

Figure 3-43 Program is stopped

When communication is interrupted by removing the voltage connector of the ILC 170
device or by changing into the "Stop Mode" through the ILC 330 PN, the value is set to "0".

If you need more detailed information, call the Diag+ diagnostic tool from PC WorX under
View-> Diag+. Here you connect explicitly to a controller and receive further information.

1}
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4 Description of a typical application
(devices in several networks)

In the following application all devices are in several networks, see also the topology
example on page 2-2.

System variables Process data

= Value 1

ILC 330 PN
PNIO_FORCE_FAILSAFE

RFC 470 PN-3TX

RFC470DEVICE_PNIO_DATA_VALID
RFC470DEVICE_PNIO_APPL_RUN

ILC 170 ETH

ILC170ETHT_0_PNIO_DATA_VALID
i_ILC17OETH1_0_PNIG_APPL_RUN

PNAr_OUT I Value 1 of PNArr_OUT PND_S1S1_INPUTS
(Value 1 is sent to the device,) Q » is linked to Q - I (Value 1is processed and returned
PND_S1S1_INPUTS to the controller.)
I | Q and forwarded. I < Q

The following devices are used for this application:

Device Order No. IP address

ILC 330 PN as master 2988191 192.168.1.3

RFC 470 PN-3TX as master 2916600 192.168.0.5

RFC 470 PN-3TX as device 2916600 192.168.1.5

ILC 170 ETH 2TX as device 2916532 192.168.0.7

FL SWITCH SMCS 4TX (optional) | 2989093 -

Laptop (higher-level network 1) 192.168.1.10
Laptop (lower-level network 2) 192.168.0.10

8037_en_00 PHOENIX CONTACT  4-1
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FE

RFC 470

LT
L i

Address area 1: 192 168.1.x
Address area2: 192 1680

Subnet: 2552552550

Figure 4-1 Typical application, devices in several networks

In this example, a project is created on the lower-level controller (ILC 170 ETH 2TX) by
requesting the status variables of PROFINET communication (PND_S1S1). For this
purpose, a function block is created in structured text that sets the value "true" on the
ONBOARD_OUTPUT_BITO system variable. The LED is ON when the ILC 330 PN sends
the value "1". This example uses two networks, the RFC 470 PN-3TX links the process data
between ILC 330 PN and ILC 170 ETH 2TX. The program is identical with the first example
application.

In the example, a function block is used for logical ANDing. The PNIO_DATA_VALID and
PNIO_APPL_RUN variables (both system variables) of the RFC map the status of the
inputs to which the PNIO_FORCE_FAILSAFE system variable is connected.

The PNIO_DATA_VALID system variable indicates for each PROFINET IO device whether
the connection to this PROFINET IO device was established successfully. Only if this bit is
set does the PROFINET IO device supply valid data and all other process values are active.

A negated result is linked to the PNIO_FORCE_FAILSAFE variable. The PROFINET
system is stable when the system variable PNIO_FORCE_FAILSAFE = 0. All outputs are
set according to the process data If PNIO_FORCE_FAILSAFE = 1 (at least one
PNIO_DATA_VALID variable set to 0), the safe state "0" is output for all PROFINET IO
device outputs.

Assign the value 1 to the PNArr_OUTI[0] variable (user variable). This is done via the
negated status of the PNIO_FORCE_FAILSAFE system variable. The value 1 is converted
in the BYTE data type, since the PROFINET process data (PND_IO_256) are assigned as
ARRAY OF BYTE data type for the variable.

4-2
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Description of a typical application (devices in several networks)

4.1 Offline configuration

411 Lower-level project

e Selectthe "New Project..." command from the "File" menu to create a new project using

a template.

The tree structure and the selection of the control system are now prepared.
e Selectthe "ILC 170 ETH Rev. >01/3.50" control system and confirm your selection with

"OK".

New Project

General | CP 3ux | CP

FCon | ILC T | ILC 200 | ILC 3w 4 * 0K

®

ILC 150 GSM/GPRS
Rew. » 014350

.

ILC 185 ETH Rev. »
01/3.50

ILCTFOETH Rew. »

T ~ Cancel
: -

ILC 185 ETH Rew. »
m/2.00

.

ILC170ETH Rev. »
01./3.00

B

(=]

Figure 4-2

¢ Select the "File, Save Project As/Zip Project As..." command.

Selecting the controller

e  Enter a project name (here: ILC170_Device) and save the project.

Savellip project as

PX

Save | |2 Projects

v|Q @ @

(C)Example
Example .k

File narne: |ILC'I 70_Device. mwt | [ Save l

File type: |ProiectFiIes[“.mwt] v| ’ Cancel ]

Zip Dptionz
Zip Uzer-Libranes
Zip Pud-Libraries
Zip Pagelayoutz

Zip Frontend-Code

Figure 4-3

Save project
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The following window opens:

%8 pc WORX - ILC170_Device

le Edit Yiew Projsct Buld Online Extras 2

£ Project Tree Window :
= 3 Project

[ Libraries

£ 43 Data Types

ik sys_flag_types
=423 Logical POUs

<Favoritess

Marne Description Ll
W ADD Addition
W AND Bitwise AMD

=-[3] Main &
- [0] MainT & CID Counter Down
| Main WCIU  CounterLip
Mair FCIUD  Counter Up/Down ]

= 28 Physical Hardware &/ Dlv Division

=8 S5TD_CNF: eCLR &ED Equal =
o 88 STD_RES:ILCT70_35 FF_TRIG Foling Edge Detection
=88 Tasks & GE Greater Than Equal: =
=-[0] STD_TSK: DEFALLT B/ GT Greater Than ; >
= (D] Main: Main & LE Less Than Equat <= T
-2 Main ;LT Less Than: <

fﬁ Global_Vanables
[ 10_Configurstion

& MOD Modulo Division
W MOVYE  Assigns Walue
& MuL Multiplication

& m | 2 E Mot Equal <>
e —— WNOT  Complement
< = A @ o) W|OR BiwiseOR 3
IP/PROFINET: Configuration is checked.
Resource is checked (STD_RES) ...
INTEREUS is checked (ILC 170 ETH 2TX, 0.0.0) ...
b\ Build f{ Emers J Wamings } Infos J PLC Emors } Print b Multi-Ussr } Bus Cenfiguratar hFDT [
For Help, press F1 62,2 ci #2GB !
Figure 4-4 PC WorX start screen
¢ Right-click on Logical POUs.
* Insert the function block.
= Project Tree firnda LA x|
Ela Project :
|23 Libraries
=] a Data Types
o oEE] sys_flag_twpes
= Insert... o,_.'l Program
| ps )
I " paste STRG4y |LE] Eunction
-] Main °.£I Function Block
B@ Physical Hard el POU group
El% STD_CH Sawe As Mebwork Template
=& STD
: T Define Placehalders
E'E % Propetties. ..
25 Maink
Ay Global Variables
il 10_Corfiguration
< 1l ] >
@Project POl= | I:@ Librarigs | E Harchnrare | Instanc:es |
Figure 4-5 Inserting the function block
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e Select the ST (Structured Text) language.
¢ Name the block "Data_Acknowledge".

Insert E|
Marne: I 0K l
| Data_Acknowlegde |
[ Cancel ]
Type Language
() Pragram D”: [ Help ]
(O Function gg%t
(#) Function Block 0O EBD
[@]1]
O FFLD [JUse Beserve
(I MSFC
tode
FLC type: Frocessar type;
| <independent: w | | <independeant: w |
Figure 4-6 Selecting the programming language and naming the function block

*  Open the worksheet by double-clicking on "Data_Acknowledge".

=53 Data Types
sys_flag_types
=223 Lu:-gu:al PDUS

m Data .&cknuwlegdeT
D ata_Acknowlegdey™
Data_scknowlegde™
= @ bd ain
[i] MainT
b i
@ b ain
=5 Physical Hardware
=-%%% STD_CNF: eCLR
=& STD_RES : ILC170_35¢
= Tasks

Figure 4-7 Opening the worksheet
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* Insert the following program to your worksheet.

1 CHBOARD OUTPUT BITO := FALSE: =
2

3 if

4 EYTE_To INT(FND_ 3131 INPUT3I[O]) = 1

5

6 then

7 CMECARD OUTPUT _EBITO := TRUE:

[s}

=l end if;

10

< »

[rata_dckn...

Figure 4-8 Inserting the program

The ONBOARD-OUTPUT_BITO system variable and the PROFINET IO device status

variable PND_S1S1_INPUTS for the process data can be found under the

Global_Variables.

¢ Select the process data length of 256 bytes (PND_IO_256) for the data exchange
between master and device.

= Project Tree Window L x| |

. Mame Twp | Verwendung | Beschreibung -~
EX= P'UIEF“ ) __|oNBOARD_INPUT_BIT2 BOOL VAR_GLOBAL  |Local input IN3 Foh
(0 Libraries ONBCARD_IMPUT_EIT3 BOOL VAR_GLOBAL  |Local input N4 Sohds
ER= D‘a Types " |onBoARD_INPUT_BIT4 BOCL WaR_GLOBAL  |Local input M5 Fohl:
_S}'S-”ag-‘ypes " |onBoARD_INPUT_BITS BOOL WAR_GLOBAL  |Local input NG Sohds
=3 Logical POUs . | GNEOARD_INPUT_BITE BOOL VAR_GLOBAL  |Local input N7 %M
=z Data_Acknowlagds | GNEOARD_INPUT_BIT? BOOL VAR_GLOBAL  |Local input NG %M
Data_AcknowlsgdeT {_[ONBOARD_OUTRUT B0 |B00L VAR_GLOBAL _|Local cutput OUTT )
Dats_Acknowlegdel/ ONBOARD_OUTPUT BT |BO0L VAR_GLOBAL |Local autput OUT2 b
Data_Acknowlegde " |oNBOARD_OUTRUT BIT2 |BOOL VAR_GLOBAL  |Local output OUT3 )
=[] Main . RTC_DAY IMT WAR_GLOBAL et
MainT | INT e (morth) %M
Mairt/ R —GCOBAL | System time (year) bt
@ Main | PHD_S151_PLC_RUM BOOL WAR_GLOBAL | Status of the higher-level control system Falx
=l Physical Hardware " |PND_S151_vALID_DATA_.. |BOGL VAR_GLOBAL IO Contraller has established the connection %I
=8 STD_CNF: eCLR . " |PHD_S151_OUTPUT_STAT.. [BOOL VAR_GLOBAL |IOF status of the higher-level cortrol system I
=8 STD_RES : ILC170_35 FND_5151_INPUT_STATUS... |BOOL VAR_GLOBAL |IOC status of the higher-level contral system I
=l Tasks : PMND_S151_DATA_LENGTH  [WORD WaR_GLOBAL  |Process data length A
=-[0] STD_TSK: DEFALLT PID_5151_QUTPUTS PID_I0_256 VAR_GLOBAL _|Output process data Gk
=3 Ma'”: '*_"""” (" [PRD_S151_INPUTS PHD_I0_256 WAR_GLOBAL |Input process data BEAE]
- 5| Mairl/ _|IB_DEVICE_PARAM_ACTI ... |BOOL WAR_GLOBAL  |Interbus device configuration activated EAH
i‘l.j £ 4 _ g IB_DEVICE_PARAM_READY |BOOL WAR_GLOBAL  [Interbus device configuration completed Sohd:

I 10_Configuration " |B_DEVICE_PARAM_ERROR |BOOL VAR_GLOBAL |Interbus device configuration error M v
< R 3 )

& '\‘.@ EB Drata_sckn... Global Wari...
Figure 4-9 Selecting the process data
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e Afterwards insert the created function block in the "Main" worksheet using drag & drop.

3 Project Tree Window L & —1| | = Edit izard 1 v
=423 Project : cyDokumente und Einstelungan A % Graup:
g Libraries <all Fllz and FB s> v
= Drata Types
=we_flag_types Eame De &
-5 Logical POUs Data_Acknow|egde 3!2 CTu Con
=@ Data_fcknowlzgde” |CTUD o
o ] Data_AcknowegdeT [Data—’a‘cmo""'|egde] & D_BCD_TO_DINT Cor
Data_Acknowlegdey W D_BCO_TO_INT Cor
Data_Acknowlegde WD _BCD_TO_SINT Cot
=-[0] Main* EPEER e
[Q] MainT # DELETE Del
Mair/” 4 DERNAT Diff
] Main B DIGITAL_IN Re.
-85 Physical Hardware® ] + 4 DIGITAL OUT St
=8 STD_ONF - eCLR 2 | | W omT T0.8 BCD
AR 4 B DINT_TO_BCD

Cor
Cot
=

<
—Iﬂ & EE’ & Mainhain ;-'mm "

w
Figure 4-10 Inserting the function block into the worksheet
e Compile the project and save it.
¢ Close the project.
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4.1.2

RFC 470 PN-3TX higher-level/lower-level project

e Selectthe "New Project..." command from the "File" menu to create a new project using

a template.

The tree structure and the selection of the control system are now prepared.
e Select the "RFC 470 PN-3TX Rev. > 00/4.6F/3.50" control system and confirm your

selection with "OK".

New Project

3

CPR || FC s | ILC || ILC 2 | ILC 3 | RFC i | Spdsise € oK

‘ ‘

RFC 450ETH IE Riev. RFC450ETH IB Rev.
» 314,60 /5.00 » 36/4.60/5.06

]

RFC 470 PH-3T Rev. [FI0EH1
» 00/4.6F/3.00

+ o
B

RFC 4705 PM-3TH
Rev. » 00/4.6F/3.50

~ Cancel

9

Figure 4-11

Selecting the controller

e Select the "File, Save Project As/Zip Project As..." command.
e Enter a project name (here: RFC470_Controller_Device and save the project.

SavefZip project as

21X

Save | 1) Projects

v|Q ¥ @

() Example
)
Example ik

File name: |HFC4?U_C0ntr0IIer_Device.mwt

L sae ]

File type: | Project Files [*.rmwt]

v| [ Cancel ]

Zip Optiong
Zip Uzer-Libraries
Zip Puy-Libraries
Zip Pagelayouts

Zip Frontend-Code

Figure 4-12 Save project
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Description of a typical application (devices in several networks)

The following window opens:

%8 PC WORX - REC470_Controller_Device

le Edit Wiew Project Buld Online Extras ?
[ Libraries ..aH FlUs and FB=»
2 4 Data Types =
! sys_flagtypes Name |
=43 Legical POUs W ABS L
i =@ Main B A0S
i j m MainT W& ADD
b airiy M ADD_T_T
- [E] Main - ADDR_TOID
) 83 Physical Hardware | AND
= &8 5TD_CNF:IPC 40 W AR_MGT
= @8 STD_RES : RFC470PN W& asiN
=8 Tasks ;ASL
E--@E| ED’;‘TSK DEEATET =
sin - Main
M ::TSED TO_DINT
f|‘3 Global Variables T G
[ 10_Configuration B_BCD_TO_INT
A B_BCD_TO_SINT
W BCO_TO_DINT
W BIT_TEST
W EOOL_TO_BYTE
M BOOL_TO_DINT
B EOOL_T0_DWORD
SRR & 2 BOOL TO_INT al
BB ey |
4 b\ Build )\ Errors ?\Wamlr\gs )\ Infos ’)\ PLC Erorz )\ Print )\ Multi-Uzer )\Bus Confi guratar )(FDT/
Far Help, press F1 63,0 ! »2GB .|
Figure 4-13 PC WorX start screen
* Right-click on Logical POUs.
* Insert the function block.
= Dro}'ect Trae Window m
Ela Project :
A Libraries
4 Data Types
F| sws_flag_types
Insert, .. oil Program
o .
i paste STrGay | &) Bunction
% Function Block
Expand all
PO group
Sawe As Metwork Template
Define Placeholders
% Properties. ..
i )
[LETri
iy Global_Variables
|0_Configuration
< Il | >
C5F Project PCOUs | WA Libraries | FE] Harchware | U] Instances |
Figure 4-14 Inserting the function block
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e Select the ST (Structured Text) language.
¢ Name the block "Data_Acknowledge".

Insert

Marne:

[

| Data_Acknowlegde

[1]8

Tupe

(") Program
(") Function
(%) Function Block

PLC type:

Language

|
[

Cancel

[

Help

[JUse Beserve

Processar bype:

Mode

| <independent:

w | | <independent:

v

3
|
|
|

Figure 4-15

*  Open the worksheet by double-clicking on "Data_Acknowledge".

=3 Data Tupes
syz_flag_tupes

=23 Logical POUs

= Data_scknowledge
m D ata_scknowledogeT
Drata_dcknowledgey
Data_sAcknowledos
= @ bk i
[i] MainT
b gt

[T

=-Z8 Physical Hardware
=-‘@8 STD_CHF : IPC_40

=% STD_RES : RFC470PN

=] Tasks

Figure 4-16

Opening the worksheet

Selecting the programming language and naming the function block

4-10
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Description of a typical application (devices in several networks)

* Insert the following program to your worksheet.

PNirr OUT[O] := PND 5131 INPUTS[0]; —

< ¥

Data_ackn..

Figure 4-17 Inserting the program

The PNArr_OUTIO0] variable is linked with the PROFINET device status variable
PND_S1S1_INPUTS, so that the ILC 170 device can call the status of the
ONBOARD_OTPUT_BITO system variable.

Select the maximum process data length of 256 bytes (PND_IO_256) for the data exchange
between ILC 330 PN, RFC 470 PN-3TX and ILC 170 ETH 2TX.

The RFC 470 PN-3TX can transmit up to 512 bytes of data, however, the process data
length is adapted to the ILC 170 ETH 2TX. It can transmit up to 256 bytes.

= Project Tree Wiindaw ¥ —
' X Marne | Type | Jza0e | Drescription |

=3 Project : | = Default
(3 Libraries PMD_S151_MPUTS PND_O_256 VAR_EXTER.. |Input process data
= ata Typﬂes t | |Prarr_ouT PND_I0_256 VAF,_EXTER. .
zyz_flag_types
=23 Logical POUs
= D ata_scknowledge
[i] Data_AcknowledgeT
Data_Acknowledgel
Data_fcknowledge
=-[0] Main
m b ainT
b ainy
@ [EET
-3 Physical Hardware
-3 STO_CMF : IPC_40
=3 STD_RES : RFC470PN
58 Tasks
= @ STD_TSK : DEFALULT
= @ i : b ain
b air
iy Global Variables
ﬁ 10_Configuration

< 2% ¥
-Igl \a @ Data Ackn...

Figure 4-18 Creating the variables
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e Afterwards insert the created function block in the "Main" worksheet using drag & drop.

= Project Tree Wiindow 1¥v[ 2 Edit Wizard 1v(Q
=3 Project - - Group:
(3 Libraries <allFls and FBs»
=3 Data Types Data_Acknowledge —
sys_flag_types Data_Acknowledge Mame Description
223 Logical POUs
=2-[@] Dats_Acknowledge W DELETE Deletes Substring
m [ata AcknowledgeT  DERNAT Differentiston with Respect to Time
Data_Acknowledgel HDIGITAL_N FRieads the digital 1/0 channel
[ata Acknowledge & DIGITAL OUT Sets the digital 1/0 chatinel
=] @ Main ) W DINT_TO_B_BCD Corwerts DINT to BCD-D'wORD
MainT M DINT_TO_BCD Canverts DINT to BCD-DWORD
Mairi/ & DINT_TO_BOOL Canverts DINT to BOOL
Main =
- W DINT_TO_BUF
=@ %PSS'CT‘B[')H;TFW?;;E 0 B DINT_TO_BYTE Canverts DINT to BOOL
= & o FES FRCATORN B DINT_TO_D_BCD Converts DINT to BCD-DWORD
¢ e - 5 ¥, | 4 DINT_TO_DWORD Comverts DINT to DWORD
- W DINT_TO_INT Converts DINT ta INT Z
@ "m m ‘- Mair:tain (. = - T 3
Figure 4-19 Inserting the function block into the worksheet
e Compile the project and save it.
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Description of a typical application (devices in several networks)

Assigning process data

e Switch to the process data assignment workspace.
* Inthe top left window, "Symbols/Variables", select the "System Variables" program.

e Highlight the PROFINET IO device in the top right window.

* Highlight the 1256 process data item in the bottom right window.

e Highlight the PNArr_OUT variable in the bottom left window.

* Enable the context menu on the variable and select the "Connect" command.

! Process Data Assignment FR 2]

SymbolsAariables =] @ RFZ470_Controller_Device
= B 5TD_CMF ; IPC_40 2-ff) RFC 470PN 3T 102, 168.0.5

= Ff Resaurce
STD_RES : RFC47OPN
=& Default R STD_RES RFC470PH

System Yariahles [=-#35 PROFINET
o (0] STo_Tsk : DEFALLT =l 1LC 170 ETH 2T (DEVICE) lc170eth1 192,168.0,7
O] Main : Main 2> D@ILC 170 ETH 2T (DEVICE)
@ | EAZSE: ILC 170 ETH 2T (DEVICE)
% # INTEREUS 0. 0

Unconnected
Symbolfvariable Data Type Process Data Item Device Process Data Itkem jflo} Data Type
PrArr_OUT PMD_IC_Z56 0 @ILC 170 ETH 2T (DEVICE) ~PNIO_DATA_STATE I BYTE

0 @ILC 170 ETH 2Ti (DEVICE) PNIC_IS_PRIMARY I BOOL

0@ILC 170 ETH 2TX (DEVICE) FNIO_DATA_YALID 1 BOGL

0 @ILC 170 ETH 2Tx (DEVICE) PNIO_APPL_RUN I BOOL

0 @ILC 170 ETH 2T (DEVICE) PNIC_MO_DIAG I BOOL

1 EAZSE: ILC 170 ETH 2T (DEYICE) (256 I Byte_256

IL! YICE) | 1256
Select all Chrl+a
Search... Chrl+F
Filter ’
w Color-coded view
Connect
Disconnect Chrl+y
Create Variable Chrl+E
< LIRS *
Figure 4-20 Linking process data
e Compile, save, and close the project.
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41.3 Higher-level project

e Selectthe "New Project..." command from the "File" menu to create a new project using

a template.

The tree structure and the selection of the control system are now prepared.

e Selectthe "ILC 330 PN Rev. > 01/4.6F/3.50" control system and confirm your selection

with "OK".

SavelZip project as

P

Save: | I Projects - |0 * = C-

L) Example
Example. rmwt

File name: |ILC330_Controller. mwt |

[ Save

File type: | Fraject Files [*.rmwt] £ |

[ Cancel

Zip Options
Zip Uzer-Libraries Zip Frontend-Code
Zip Faf-Libraries
Zip Fagelapouts

Figure 4-21 Selecting the controller

e Select the "File, Save Project As/Zip Project As..." command.
e Enter a project name (here: ILC330_Controller and save the project.

Save/Zip project as \ @

Spejchemn |E.'l Projects v|0 ¥

® [~

[ Example
Example. rmwk

Dateiname: |ILC330_Cantroller.mist |

[ Save ]

Dateityp: | Project Files " ) v|

[ Abbrechen ]

Zip Options
Zip Uzer-Libraries Zip Frontend-Code
Zip Pu-Libraries
Zip Pagelayouts

Figure 4-22 Save project
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Description of a typical application (devices in several networks)

The following window opens:

!"sj PC WORX - ILC330_Controller

i Fle Edit ¥iew Project Buld Online Extras ?

H
B
.

3 Project

RN 8. 7 - |

Group:

For Help, press FL

[ Libraries all FUs and FBz>
=23 Data Types "
i sps_flag_types Name DE:f
=423 Logical POUs A4S T—
= [H] Main W AC0s Aic
~[i] MainT W ADD A
Mairy W ADD_T_T Tik
[T Main W ADDA_TO_ID
=@ Physical Hardware M AND Bit
-4 STO_CNF : ARM_L_40 B4R _MGT
= @8 5TD_RES : ILCII0PN = s
=l Tasks /AL
=-{0] STD_TSK: DEFAULT B 45R
=@ a'”Ni il A ATAN Aec
% Global Varbles M 10 D L
El? 10 Eo;ﬁgulat\on L ER L Tl
- B BCD_TO_SINT Cot
B ECD_TO_DINT Cor
MW BIT_TEST Loz
W BOOL_TO_BYTE Cot
& = | 5 B BOOL_TO_DINT Cor
# BOOL_TO_DWORD Cot s |
R EGE ] || 3
IP/PROFINET: Configquration is checked.
Resource is checked ([STD_BEJ] ...
INTEREUS is checked (ILC 330 PN, 0.0.0) ...
5
=
Z |4 b \euid f Evor }, Warnings J Infes b PLC Ewors b Print ) Multi-User } Bus Configurator AFDT J
10,7 ©o2GE

Figure 4-23 Start screen
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Integrating the RFC 470 PN-3TX as PROFINET IO device

The following section describes how you integrate the RFC 470 PN-3TX as PROFINET
device in the "ILC330_Controller" project.

¢ Change to the bus structure. To do this, click on the "Bus Structure" icon in the

toolbar.

* Insert the RFC 470 PN-3TX as a device into the bus structure (right click).

= Bus Structure 1 4
= @ 1LC330_Controller
= Fll ILC 330 PM 192,168.0.2
=R Resource
R STD_RES ILCI30PN
#4 PROFINET
=98 # INTERBUS 0, 0
PE#1mEL24D140.1

Unconnected

& Device Catalog 14

=43 Phoenix Cantact a
o AL
-] CP3ux
# [ CT
#-(] ELR
-] FC24x
-] FC3xx
B FOT
B FL
-] FLM
B FLS
w1 FP
7L
B IL 2MBD
B ILB
-] ILCT=x
-] ILC20x
- ILC3mx
# ] IP
-] 154/PCI
B LOOP 2
-] NFCx
=] OPTOSUB
#-(] OPTOSUB 2MBD
#7107
-] PSM
=43 RFC4xx
=43 PLC
(3 RFC 430 ETHE Fev. |
(3 RFC 430 ETHE Fev. |
(3 RFC 430 ETHE Fev. |
(3 RFC 430 ETHE Fev. |
3 RFC 450 ETHE Rev. |
() RFC4S0ETHAE Rey. |  View as Grid CirhG
{3 RFC 450 ETHAE Rev. | Edit Catalog Representation. .. Chrl+E
FC 470 PN VICE) B

Insert Dev E
Import Device... Chrl+1
Copy Device Chrl+C

Display Data Sheet
Delete Device

Import GSD File. ..
Create new INTERBIS Device Description, ..

Create Catalog ...
Import Catalog ...

Figure 4-24 Insert the RFC 470 PN-3TX as a device into the bus structure
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Description of a typical application (devices in several networks)

The PROFINET device inserted will be displayed in the Bus Structure workspace. The IP

address is created depending on the IO controller address.

2 Bus Structure 2 & [/ |3 Device Details ER A
= % ILC330_Contraller RFC 470 P 3Tx (DEVICE) RFC470PM1 192,168, 1.5 \PROFINET Settingsh,
=0l 1L 330 PN 192.168,1.2
=& Resource Mame Value
R 5TD_RES ILC330PN [ | vendor Phoenizx Conkack
=% PROFIMNET [ | vendorlD 00080
= [ | Designation RFC 470 P 3T% (DEVICE)
[ | DeviceID 00032
1 EASL2: RFC 470 PM 3T (DEVICE) [ | Functional description
= ﬁ # INTERBUS 0. 0 [ | Device bype FLC
Uncﬁ;t_t{aéﬁ 2401401 [ | Device Family RFCean
(% | Order rumber 2916600
[ | Revision XX
[ | DMS/PROFINET Device Mams RFC470PM1
= " ] Station Mame
= Device Catalag 2 a4 [ | Dovice Hame
#-(] Festo [ | Module Equipment 1D
(3 Phoenix Cantact 3 | 1P Address 192.166.1.5
¥ (3 Uriversal [3 | subnetmask 255,255,250
[ | Defaul Gateway
[ | Realtime class RT
O Reduction ratio input 16 ms
B Reduction ratio oukput 16 ms
[ | Faulky telegrams until connection is aborted iz
[ | Monioring Time Inputs {ms) 192
[ | Monicoring Time Outputs {ms) 192
[ | Operation in case of configuration differences no
O Log connechion state YES
B Drive BF YES
[ | WodeID i

= Bus Struchure

Figure 4-25
structure

B\ ppOFINET Settings | B8 PROFINET Stationnames | ¢

The RFC 470 PN-3TX integrated as a PROFINET IO device in the bus

Bus interfaces | & Data sheet

The process data of the PROFINET device will be displayed in the Device Details

workspace of the "Process Data" tab.
1a0d

% Device Datails

= @ 1LC330_Cortraller
=R Resource

=-#4# PROFINET

= Flll ILC 330 PN 192.168.1.2

R STD_RES ILC330PN

1 EAS1Z: RFC 470 PN 3T4 (DEYICE) \Process Datal,

2v@

Process Data Byte. Eit

1iq Function Text

Terminal equi...

O [ o5tz [ [oo [1
O | =z | Too [ o

=1 [if) RFC 470 P 3T (DEVICE) RFC470PNL 192.166.1.5
B 0@RFC 470 P 3TX (DEVICE)
1EAS12: RFC 470
= % # INTEREUS 0, 0
| ERSCIRZTELIN!

Unconnecked

2 Madula Catalog
i EA128: RFC 470 PN 3T [DEVICE)

1ad

EA256: RFC 470 PH 3T [DEVICE])

EA3Z RFC 470 PN 3T (DEVICE)
@ 4512 RFC 470 PN 3T (DEVICE)
@ EAG4: RFC 470 PN 3T [DEVICE)

<

oni

Al

S Module Settings | ¥ Process Data

%] Data sheet

Figure 4-26

Process data of the PROFINET IO device

Replace the EA512 I/O module with the EA256 I/0O module of the RFC. As a device the
lower-level ILC 170 ETH 2TX can transmit up to 256 bytes.

Delete the EA512 I/O module (right click).
Drag the EA256 1/0O module in the bus structure (left click).

The RFC 470 PN-3TX is now available as PROFINET IO device in the "ILC330_Controller"
PC WorX project.

8037_en_00
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e Switch to the IEC programming and open the "Main" worksheet.
[TH

e Add the mapped function blocks.
*  Create the following variables at the links as specified.
¢ Negate the output at the AND block.

>

AND
PMNIO_DATA_VALID: C—PNIO_FORCE_FAILSARE

PINIO_APPL_RLM

NOT BOOL_TO_BYTE
PNIO_FORCE_FAILSAFE«[

< >
B Mainbain

Figure 4-27 Adding function blocks

e Save the modified main program.
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Description of a typical application (devices in several networks)

Assigning process data

For the system variables for displaying the status of a PROFINET IO device, the process

data is generated automatically.

e Switch to the process data assignment workspace.

e Inthe top left window, "Symbols/Variables", select the program

(here: Main : Main).

¢ Highlight the PROFINET IO device in the top right window.

¢ Highlight the PNIO_DATA_VALID variable in the bottom right window.

e Highlight the PNIO_DATA_VALID variable in the bottom left window.

e Enable the context menu on the variable and select the "Connect" command.
*  Proceed in the same way for the PNIO_APPL_RUN variable.

2 Process Data Assignment 1v[
SymbalzAariables = @ ILC330_Controller
= ‘@a STO_CNF @ ARM_L_40 H ! ;;C :ZSE;ZIE'S'I'Z
=& STD_RES : 1LC330PN R STD_RES 1LC330PN
befaul: =3 PROFTMET
i g:;te;"s:a.fifuu - () RFC 470 PN 3T% (DEVICE) RFC470PN1 192,168.1.5
=@ R B A 0 @RFC 470 PN 3T4 (DEVICE)
"E' ; G'E 1 EAZSE: RFC 470 PN 37X (DEVICE)
i = ¢ # INTEREUS 0. 0
e PE+#imLz4D40.1
Unconnected
Symbolivariable Data Type Process Data Ikem Device Process Data Ikem jfle] Data Type
PNIO_ARPL_RUN BOOL 0 @RFC 470 PN 3T (DEYICE) ~PNIO_DATA_STATE i BYTE
PNIO_DATA_VALID BOOL PMIO_IS_PRIMARY 1 BOOL
PMIO DATA YALID S
0 @RFC 470 PN 3T (DEYICE) PMIO_AFPL_RUN Select &l Ctri+a
0 @RFC 470 PN 3T (DEVICE) PNIO_NO_DIAG Search... ChrF
1 EA2SE: RFC 470 PN 3TK (DEVICE) Q256
1 EAZS6: RFC 470 PN 3TX (DEVICE) 1256 Filter »
v Color-coded view
Connect Ctrl+E
Disconnect Chrl+Y
Create Variable Ctr+E
< 2 |£ >
Figure 4-28 Linking variables
* Inaddition, create the "PNArr_Out" variable with the "PND_IO_256" data type as "VAR-
EXTERNAL".
Mame Type Uszage Description
[=] Defautt
_|PMIO_FORCE_FAILSAFE BOOL WAR_EXTER... Al PROFIMET devices are prompted to set their .
PRIC_APPL_RIUR BOOL WAR_EXTER...
_|PMIO_DATA_WALID BOOL WAR_EXTER...
_|PMA Ot PMD_O_256 WAR_EXTER...
< >
P& Maintain Il aini':h ain
Figure 4-29 Creating the "PNArr_Out" variable
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e Connect the "PNArr_Out" variable to the "I256" process data item of the

RFC 470 PN-3TX device.

later in the online configuration.

The total available data width of 256 bytes was selected in this example. You can change it

2 Process Data Assignment 1vpm
Symbols/Yariables = @ 110330 _Controller
=l 1LC 330 PN 192.168.1.2
= ‘B8 STD_CHF : ARM_L_40
=) {88 STD_RES | 1LC330PN il ?;SZ#EERES ILC330PN
Defaul " =1 48 PROFINET
System Varizbles = £ RFC 470 Ph 3T (DEVICE) REC470PNI 192,168.1,5
=-[0] 5TD_TSK .: DE_FRULT @ & 0 @RFC 470 Ph 3T (DEVICE)
= (3 Main: :ﬂa"” 1 EAZ56: RFC 470 PN 37X (DEVICE)
Default = f% # INTERBUS 0, 0
& dute B#iEnzo40.1
Unconnected
Symbolfvariable Data Type Process Data Item Device Process Data Item ire] Data Type
PRAr_OUE PID_IO_256 0 @RFC 470 PR 3T (DEYICE) ~PHIO_DATA_STATE 1 BYTE
0 @RFC 470 PN 3T (DEWICE) PRLO_IS_PRIMARY I BOOL
0 @RFC 470 PN 3TX (DEVICE) PNLO_DATA_VALID I BOOL
0 @RFC 470 P 3T (DEVICE) FRIO_ARPL_RUN I BOOL
0 @RFC 470 PN 3T (DEYICE) PHIO_MO_DIAG I BOOL
1 EA256: RFC 470 FI 37X (DEVICE) Q256 I Byte_256
1 EAZ! C 470 PN 3T (DEVICEY [ 1756 FE 6
Select all Chrl4+a
Search... Chr+F
Filter 3
w Color-coded view
Disconnect Chrl+y
Create Variable Chr+E
¢ El S >
Figure 4-30 Connecting the "PNArr_Out" variable to the process data
e Switch to IEC programming and link the variables as shown in the figure below.
=
~
AN
[_ILCI70ETHL_O_PMNIO_DATA_WALID C—PMNIO_FORCE_FAILSAFE
[LILCI70ETHL_O_PHIO_APPL_RIUMN
MNOT BOCL_TO BYTE
PNID_FORCE_FAILSAFE PArT_Cut0]
v
< 3
T MainMain
Figure 4-31 Inserting and linking variables
e Select the "0" array in the byte array by writing the field "[0]" after the "PNArr_Out"
variable.
e Then compile the project and save it.
4-20 PHOENIX CONTACT 8037_en_00

DOWNLOADED FROM WWW.SCATTS.CO.UK



DOWNLOADED FROM WWW.SCATTS.CO.UK

Description of a typical application (devices in several networks)

4.2  Online configuration

4.2.1 Preparing the PC for communication

e  For configuration and parameterization assign an appropriate IP address for your PC
within the 192.168.0.x address area. In this example the PC receives the address
192.168.0.10.

Internet Protocol (TCP/IP) Properties

General |

You cah get IP settings assigned autormatically if yaur network supports
thiz capability. Othemvize, pou need bo azk your network, administrator for
the appropriate [P settings.

() Obtain an IP address automatically
(%) Uze the following IP address:

P address: 192 1688, 0 .10
Subnet mask: AR 2R .25 . 0

(%) Use the fallowing DMS server addresses:

Preferred DNS server: I:I

Alternate DNS server

[ Ok H Cancel ]

Figure 4-32 Assigning an IP address

e Select the network card of your PC that is to be used for communication in the
"Tools/PROFINET..." menu of PC WorX.

PROFINET] X

Communication |

Ethemet Network Board Generic Marvel Yukon B8EE053 based Ethernet Contraller - SecuRem v

Flease choose...

DCP Timeout

[ K. ] [ Canceal

Figure 4-33 Selecting the network card

Now the PC is ready for communications within the subnet.

Set the address 192.168.1.10 for the higher-level network with the ILC 330 PN as a
master and the RFC 470 PN-3TX as a device. Set the address 192.168.0.10 for the lower-
level network with the RFC 470 PN-3TX as a master and the ILC 1770 ETH 2TX as a
device.

o
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4.2.2 Configuring the ILC 170 ETH 2TX

Assigning IP settings

To set the IP address in PC WorX proceed as described below:

e Open your project "ILC170_Device".

e Establish an Ethernet connection between your PC and the controller.

* Inthe PC WorX menu bar, select the
"Extras... BootP/SNMP/TFTP-Configuration..." menu.

|52 PC WORX -

File Edit Wiew Project Build Online Extraslz
¢ L Pagelayout Editor
D& &% =" i
- | Create OPC Yisualization File
C15 55 B e [y o e

= Buz Struckure

Reset DA-Addresses

PROFIMET Configuration ...

| BootPfSMMP I TFTP-Configur ation ...

Check Source Storages
Shortcuts, ..

options. ..

Figure 4-34 Selecting "Extras/BootP/SNMP/TFTP-Configuration..."

e  Activate the "BootP server active" checkbox.

BootP Settings &l

BootP ‘

Figure 4-35 Activate BootP server

e Switch to the bus configuration workspace, see Figure 4-37
e  Select the controller node.
e Select the "IP Settings" tab in the "Device Details" window.

¢ Enter the MAC address of the controller. It is printed on the device and starts with
00.A0.45.
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Figure 4-36

2 Bus Structure

7805A012
Printed MAC address on the ILC 150 ETH controller

1 & [/ |5 Device Details

= @ 1L.C170_Device
-l ILC 170 ETH 2T% 192.168.0.7

ILC 170 ETH 2T 192,168.0.7 1IP Settings),

rym

=R Resource Mame Yalue
R STD_RESILC170_35 [ | vendor Phoenix Contack
ﬁ # IMTEREUS 0. 0 [% | Designation ILC 170ETH2TY
Unconnected [ | Functional description Inline Controller For Ethernet Netwarks With & ...
s} Dewice bype PLC
[ | Device Family ILCixx
[ | Order number 2918532
[ | Revision 01/3.50
= Device Catalog 2 afd [4 | Station Mame
7 Festo [ | Device Name
%] Phoenix Contact [ | Module Equipment ID
i-C7 Universal O DMS/PROFINET Device Name ILC170ETHL
[ | MAC Address 00-A0-45
[ | 1P Address 192.166.0.7
[ | subnetmask 255.255,255.0
4 | Default Gateway
Al @ IF Settings E Extended Settings | o Communication h CPL Service Editar | 5% Businterfac ¢ &
Figure 4-37 Entering the IP address

e Perform a cold restart for the controller.

e To do this, switch the supply voltage off and then on again after around 2 seconds.

The controller is assigned the IP address, which is specified in the project for the controller
(here: 192.168.0.7). The following message appears in the message window in the "Bus
Configurator" tab.

] Conficured dewvice (ILCL70ETHL) queries for its IP parameters wia BootP.
: The dewvice (ILCL70ETHL) receiwed its IP parameters (IP Address:192.168.0.7,5ubnet Mask:255.255.255.0,Default Gateway:) wia BootP.
e
=
&
?‘: % Build }, Errors Ji Wamings Ji Infos J, PLC Emors J, Print | Multi-User } Bus Corfigurator A FDT J
Figure 4-38 Message window
The IP address will now be permanently stored on the controller Flash memory.
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4.2.3 Configuring the RFC 470 PN-3TX

By default upon delivery the diagnostic display has the following status:

CONTROL
RDY
Projectname: .
|
INTERBUS MASTER
RDY |
e @
PROFINET CONTROL
WAIT
L 16
|
PROFINET DEYICE i
WAIT |&
L
[ |

Figure 4-39 Diagnostic display

The initial assignment of the IP settings can generally always be carried out using the
diagnostic display.

When using the PC WorX software, the initial assignment of the IP settings can be carried
out with BootP or using the COM1 serial interface.

e Ifthe Remote Field Controller already has IP settings that are valid in your network, you
can modify the IP settings via the network using PC WorX.

e Setthe RFC 470 PN-3TX to the mapped IP address 192.168.0.5. It can be accessed in
the network after a restart of the device.

SYSTEM MENU
IP Config LAN1 @

SYSTEM MENU
IP Config LAN1 &

IP Parameters for LAN1 7

IP Address © 0.0.0.0 . a

Subretmask : 0.0.0.0

Gateway : 0.0.0.0 E! a

MAC address : 00.A0.45.12,EE.C9
MASC LAML : 00,40,45.12 2e.ch

MAC LAMLZ ¢ 00,A0.45,12.e8.c0 192.168.000.005

Edit Subnetmask (LAN1)

Edit Gateway (LAN1) B V]
PLC 1B MASTER PMH-C | PM-D E PLC IE MASTER PN-C | PMN-D E
bR @EHE 00 @ |; N S8R0 09® |

Figure 4-40 LAN1 configuration display

The procedure for assigning the IP settings is essentially the same for the LAN1
(LAN1.1/LAN1.2) and LAN 2 interfaces. The following describes the assignment of the IP
settings at the LAN1 interface as an example. The LAN1.1/LAN1.2 interfaces are switched
internally. Thus, both ports can be accessed using the IP settings defined.
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For the LAN2 interface proceed as in the previous example, however, set the IP address to
192.168.1.5. The RFC 470 PN-3TX communicates with this address as a device.

NOTE:
@ The IP address of your PC must be in the same subnet as the LAN1 or LAN2 interface of
the RFC 470 PN-3TX. Only then is communication for configuration of the ILC 170 ETH
2TX possible.
In this case the modification was done via the LAN1 interface (192.168.0.x subnet).

4.2.4 Configuring the ILC 330 PN

Assigning IP settings

¢ When assigning the IP settings for the ILC 330 PN, please proceed in the same way as
for the ILC 170 ETH 2TX, see "Configuring the ILC 170 ETH 2TX" on page 4-22.

*  Open the "ILC330_Controller" project.

Please not the following modifications:

Connect the network cable of your PC to the switch. Now you have established a connection
from the PC to the ILC 330 PN.

— BootP server is active

—  Enter the MAC address of the ILC 330 PN controller.

— Assign the IP address 192.168.1.2.

Switching on the 10 PROFINET device function

° The following applies to the devices:

1 ILC 170/330/350/370/390 PN / RFC 470 PN-3TX
By default upon delivery the PROFINET device function is switched off for every controller.
To switch it on, start your existing project (in the example here: "ILC170_Device") in PC
WorX and activate the PROFINET device function as follows:
e Switch to the "Extended Settings" tab.
e  Select the "IO device status" item in the device details under "Network Settings".
e Under "Settings", select "activated" in the pull-down menu.
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& Device Details E x|
ILC 170 ETH 2T 192,165.0.7 \Extended Settings)
23 Metwiork Settings :
5| Ethernet Settings
| SMMP agent deactivated b’
10 device status
PROFIMET Device deactivated
T T T
Offline

B\ 1P Settings | E Extended Settings | A Communication || £ CPU Service Editor | 5% Bus interfaces | ] Data sheet

Figure 4-41 Device function activated

e Click on "Transmit".
* Inthe "Settings Communication Path" dialog confirm with "OK" the suggested IP
address or the one you have selected for your application.

Settings Communication Path fz|
| Ethemet [132.168.0.7) v/
[ ok i [ Cancel ]

Figure 4-42 Setting the communication path

Successful execution of the service will be displayed in the status window.
+vQ

2 Device Details

ILC 170 ETH 2T% 192,168.0.7 \Extended Settings)

=3 Metwork Settings
5] Ethernet

E’ SHMP agent ‘activated P
3] 10 device status
%] PROFINET Device

Settings

e Satt\ngs| E Extended Settings |‘ Communication | %f§ CPU Service Editor | 4% Bus interfaces | B Data sheet

Figure 4-43 Status window

To transfer the network settings you have to reset the 10 controller.
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e Select the "Ethernet" item in the Device Details window under "Network Settings".

1}

The device name in the higher-level project (ILC 170 ETH device) must match the device

name of the lower-level project (ILC 170 ETH).

* Inthe "Activate Network Settings" area click the "Reset Control System" button.

= Device Details

ILC 170 ETH 2TX 192.168.0,

5 Metwark Settings
SMMP agent

%] 10 dewice status
5] PROFINET Device

L8]
7 \Extended Settings!
Metwark Settings
() Manual definition of the TCPIP settings
IP Address:
[z 168 . 0 . 7 ||
Subnet Mask:
| 285 25 . 2% . o0 |
Gateway Address:
O Usage of a BookP Server
DHSPROFINET Device Mame
| ILCI70ETHL | Send ]
Reeal-time Clock Settings
Time:
|10:UU:31 : | System Time
Date:
| Morkag 29, Wiz 2010 3| Send
Settings
[ Read ]
Activate Network Settings
[ Reset Control System ]
FTP
[ Open FTP Folder on Device ]
[Oifine
B op Sattings‘ E Extendsd Settings |J Communication | £[§ CPU Service Editor | 4% Bus interfaces | 5] C ¢ »

Figure 4-44

Resetting the controller

* Inthe "Settings Communication Path" dialog confirm with "OK" the suggested IP
address or the one you have selected for your application.

Settings Communication Path

X

|Ethemet [132.162.0.7) |
| ak. i [ Cancel
Figure 4-45 Setting the communication path
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Successful execution of the service will be displayed in the status window.

Activate Metwork Settings

FTP

I ()

@ IP Settings E Extended Settings ‘ Communication j CPU Service Editor | 5% Bus inkefaces ﬂ Cd s

Figure 4-46 Status window

The input/output data ranges available for the ILC 170 ETH 2TX as PROFINET IO device
are displayed under "Network Settings" -> "PROFINET Device".

2 Dewvice Details E x|
ILC 170 ETH 2T% 192,168,0,7 \Extended Settingst

3 Mebwork Settings M ame Walue =]
=| Ethernet 1 |Input range 286 bytes -
SMMP agent 2 | Output range 256 bytes -

-
| | »

B 1P Settings E Extended Settings | # Communication | 5 CPU Service Editor | 5% Bus inkerfaces | B Data shest

Figure 4-47 Input/output data ranges

Setting the update task

To set the update task, select the device resource in the Bus Structure window.
e Setthe update task to "DEFAULT".

= Bus Structure 2 w | |5 Device Details LR x|
= % ILC170_Device STD_RES ILC170_35 \Resource),
=l ILC 170 ETH 2T 192.165.0.7
= /7 Resource MName Value
¢ STD_RESILCI70_35 ™ Configur ation STD_CHNF
ﬁ # INTERBUZ O . 0 [ Resource name STD_RES
Unconnected 3 | PLC bype arLR
D Processar Eype ILC170_35
[ | 1o Update by Task <DEFALILT =
@ Resource
Figure 4-48 Setting the update task
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4.2.5 Observe startup behavior

To use the PROFINET device functions, the following conditions apply for the
"ILC330_Controller" project.

Higher-level controller: ILC 330 PN
Controller settings:

IP address: 192.168.1.2
Subnet mask: 255.255.255.0
PROFINET device name: ILC330PN1

RFC 470 PN-3TX settings as a PROFINET IO device
IP address: 192.168.1.5

Subnet mask: 255.255.255.0

PROFINET device name: RFC470PN1

To use the PROFINET device functions, the following conditions apply for the
"RFC470_Device" project.

RFC 470 PN-3TX settings as a PROFINET IO controller
IP address: 192.168.0.5

Subnet mask: 255.255.255.0

PROFINET device name: RFC470PN1

ILC 170 ETH 2TX settings as PROFINET IO device:
IP address: 192.168.0.7

Subnet mask: 255.255.255.0
PROFINET device name: ILC170ETH1

Please make sure that the same PROFINET device name of the RFC 470 PN-3TX 10
controller (here: RFC470PN1) is used in the lower-level project as in the higher-level
project for the RFC 470 PN-3TX as a device (here: RFC140PN1).

Starting up the controller is the easiest way to check whether

— The controller is correctly parameterized

— The I/O devices have the right name

— There are double names or double IP addresses in the system.

Make sure that the controller has the IP address that was set in the project. Start the project
control dialog via the menu bar.

If the message "Timeout" appears after 10 seconds, the project and device addresses do
not match. It is also possible that the IP address of the computer has not been set correctly.
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The controller can be reset from the project control dialog. The existing project will be
deleted. Start the download and perform a cold reset. Afterwards the BF LEDs must go out

on all devices.

To access the network status from the program, the following system variables are mapped
in the global variables of the programming environment. Activate the "Debug On" operating
mode and the values of these variables will be displayed.

Global variable

Description

PNIO_CONFIG_STATUS_ACTIVE

Connection to these devices is being established
or has been completed.

PNIO_CONFIG_STATUS_READY

The connection establishment to the devices has
been completed.
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4.2.6 Checking the program start of the higher-level project

¢ Open the "ILC330_Controller" project.

When the program is started correctly, the following screen will be shown in the Debug

mode:
—1
-
PrRIC_DATA_VALID FPIO_FORCE_FAILSAFE
1 0
PHRIC_APPL_RLIMN
1
MOT BOOL_TO_BYTE
PrID_FORCE_FAILSAFE MArT_Out[0]
0 16801
hd
< »
L& HainMain

Figure 4-49 Program status

The PNIO_FORCE_FAILSAVE variable is in the FALSE state, thus communication is
ensured and the outputs are set according to the process data.

If you remove the voltage connector of the RFC 470 PN-3TX or change the device to the
"Stop Mode", the status of PNIO_FORCE_FAILSAFE will change to TRUE. All outputs will
be set to "0" and the value "1" is no longer transferred to the device.

—1
-~
PRIC_DATA_WVALID FNIO_FORCE_FAILSAFE
1 1
PHIC_APPL_RLM
0
NOT BOOL_TO_BYTE
PHIO_FORCE_FAILSAFE AT Out[0]
1 16400
w
< >
& tairnMain
Figure 4-50 Program status in "Stop Mode"
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4.2.7 Checking the program start of the lower-level project

The behavior described before can also be observed in the ILC170_Device project. Please

note that the RFC 470 PN-3TX is operating as a master and as a slave at the same time. It

acts as the link between the ILC 330 PN controller and the ILC 170 2TX controller.

¢ Please open the lower-level project of the ILC 170 ETH 2TX.

e Thenopenthe "Data_Acknowledge" POU and activate the Debug mode. The following
screen appears:

1 FALSE (ONBOARD OUTPUT_EITO := FALZE: =
2
3 if BYTE_To INT(PND 3131 INPUTS[0]) = 1
4
5 then
& FLLSE CMNEOARD OUTPUT_EITO := TRUE:
7
(=] end_if;
=]
s >
Walue Default value Type Instance
| | |PND_I0_28 |STD_CNFSTD_R..

[0 (T ERO0! BYTE STD_CMFSTDR..
3 11 1EHO0 EvTE STD_CMFSTDR..
b [2] 1EHO0 EvTE STD_CMFSTDR..
_% [3] 1EHOO EYTE STD_CMFSTD_R..
_é: Y wistoh 1 f Watch 2 ) Watch 3 i Watch 4 ]
Figure 4-51 Program status active

The value 1 is in array [0] of the PND_S1S1_INPUTS. The ONBOARD_OUTPUT_BITO
variable is TRUE and the Q1 LED on the ILC 170 2TX is ON. Now switch the PROFINET IO
controller (ILC 330 PN and/or RFC 470 PN-3TX) to stop. Communications is terminated and
the value is set to 0. The LED goes out as well, because the ONBOARD_INPUT_BITO
variable is reset to FALSE.

1 TRUE |ONBOARD OUTPUT EBITO := FALSE: =

2

3 16#01 |if BEYTE_TO INT(PND_3131 INPUTI[0]) = 1

4

5 then

& TEUE CNEOQARD OUTPUT _EITO := TRUE;

7

(=] end if;

=]

NES >

Data_dckn..

E Wariable Walue Drefault value Type Instance
[ERFHD S1S1_WPUTS | | [PND_I0_255 | STD_CHFSTD_R..

[0] 1EH0 BYTE STD_CWF.STD_R...

3 11 1E#O0 BYTE STD_CWF.STD_R...

= [2] 1E#O0 BYTE STD_CWF.STD_R...

E [3] 1E#O0 BYTE STD_CHF.STD_R...

_é: ' wistch 1 Watch 2 Jy Watch 3 J, Watch 4 ]

Figure 4-52 Program is stopped

When communication is interrupted by removing the voltage connector of the ILC 170
device, a BF error appears on the RFC display at the PROFINET controller.

If you need more detailed information, call the Diag+ diagnostic tool from PC WorX under
View-> Diag+. Here you connect explicitly to a controller and receive further information.
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